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Introduction

This document explains the XINS functionalities. It starts by explaining how to create and run asimple
API and continue by explaining the more advanced features.

What is XINS?

XINS s an open-source Web Services framework.

XINS supports POX-RPC, SOAP, XML-RPC and more. It consists mainly of an XM L-based specification
format and a Java-based implementation framework. From its specifications, XINS can generate HTML,
WSDL, client-side code, server-side code, test forms and more.

Notation

This document uses the Windows file system. If you are installing XINS in a Unix operating system like
Mac OS X, linux or Solaris, change all back slash characters (\') with aforward slash character (/') in the
file names of this document.

The documentation provides some Javadoc links that only work inthe HTML generated user guide.

Requirements

XINS requires the following software:

« Java Development Kit 1.5 or higher: http://www.oracle.com/technetwork/javaljavase/overview/
index.html.

If not done by the installation, you should set the environment variable JAVA HOVE to the directory
where you have installed Java. Also add the % AVA_HOVE% bi n directory to the PATH environment
variable. You can check the Javaversion installed by executingj ava - ver si on.

If you want to use XINS with Java 1.3.1 or Java 1.4, you can download XINS 2.3.
XINS has been tested with Java 5.0, Java 6.0 and java 7.0.
» Ant: http://ant.apache.org/, version 1.6.2 or higher.

Y ou should set the environment variable ANT__HOME to the directory where you have installed Ant.
Also add the %ANT_HOVE% bi n directory to the PATH environment variable. Y ou can check the Ant
version installed by executing ant - ver si on.

Caution

If you have a putDocumentinCache error message in Eclipse, you may need to copy
xercesimpl-2.6.2.jar [http://mirrors.ibiblio.org/pub/mirrors/maven2/xerces/xercesimpl/2.6.2/
xercesimpl-2.6.2.jar] in the eclipse\plugins\org.apache.ant_1.6.5\1ib
directory.



http://www.oracle.com/technetwork/java/javase/overview/index.html
http://www.oracle.com/technetwork/java/javase/overview/index.html
http://ant.apache.org/
http://mirrors.ibiblio.org/pub/mirrors/maven2/xerces/xercesImpl/2.6.2/xercesImpl-2.6.2.jar
http://mirrors.ibiblio.org/pub/mirrors/maven2/xerces/xercesImpl/2.6.2/xercesImpl-2.6.2.jar
http://mirrors.ibiblio.org/pub/mirrors/maven2/xerces/xercesImpl/2.6.2/xercesImpl-2.6.2.jar
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If you're using the Ant distribution included with NetBeans and have putDocumentinCache
error messages, you should change the Ant home location to Ant 1.7.0 or higher (in Tools -
> Options -> Miscalleneous -> Ant.

* Optiona: A servlet container. For example: Tomcat [http://tomcat.apache.org/] or Jetty [http://
jetty.codehaus.org/jetty/index.html]. Any J2EE server can aso deploy web applications. For
example: Glassfish [https://glassfish.dev.java.net/], Orion [http://www.orionserver.com/], JBoss [ http://
www.jboss.org/], WebSphere [http://www.ibm.com/software/infol/websphere/index.jsp], WebLogic
[http://www.bea.com/products/webl ogic/server/index.shtml], Resin [http://www.caucho.com/resin/] or
JRun [http://www.macromedia.com/software/jrun/?promoid=home_prod_jr_100803].

For theinstallation of the servlet container, please refer to the documentation of the downl oaded product.
XINS containsit's own servlet container implementation for basic testing purposes only.

e Optional: A version control system. For example CV S[http://www.cvshome.org/] or Subversion [http://
subversion.tigris.org/].

This document will assume that you have installed Java and Ant.

Installation

XINS can be installed using the Windows installer or by downloading the . t gz file and unzipping the
file. Both options are explained below.

Windows Installer

» Download xins-3.0.exe [http://prdownl oads.sourceforge.net/xing/xins-3.0.exe?downl oad] and execute
it. A new directory c: \ Progr am Fi | es\ xi ns is created.

« If you choose to compile and run the demo, you can go to the link provided in the READMVE file, then
click on MyFunct i on and on the MyConput er links in the examples section or use the test form
link provided on this page.

Using the .tgz file
» Download XINS 3.0 [http://prdownl oads.sourceforge.net/xins/xins-3.0.tgz?downl oad] .
» Unpack the downloaded file (xi ns- 3. 0. t gz) to adirectory.
 Set the environment variable XI NS_HOVE to the xi ns directory.

* Add the path %XI NS_HOVE% bi n to your PATH environment variable

Note

On Windows, the new environment variable will not be set until you have rebooted or logged
on again. If you don't want to reboot your computer, you can set the variables with set
XINS HOME=c:\Program Files\xins and set PATH=%PATH% ;% XINS HOME%\bin in
aDOS prompt.

You are now ready to create your first XINS project.

Code conventions

API names should bein lowercase. E.g. bi | | i ng (andnot Bi | | i ng).



http://tomcat.apache.org/
http://tomcat.apache.org/
http://jetty.codehaus.org/jetty/index.html
http://jetty.codehaus.org/jetty/index.html
http://jetty.codehaus.org/jetty/index.html
https://glassfish.dev.java.net/
https://glassfish.dev.java.net/
http://www.orionserver.com/
http://www.orionserver.com/
http://www.jboss.org/
http://www.jboss.org/
http://www.jboss.org/
http://www.ibm.com/software/info1/websphere/index.jsp
http://www.ibm.com/software/info1/websphere/index.jsp
http://www.bea.com/products/weblogic/server/index.shtml
http://www.bea.com/products/weblogic/server/index.shtml
http://www.caucho.com/resin/
http://www.caucho.com/resin/
http://www.macromedia.com/software/jrun/?promoid=home_prod_jr_100803
http://www.macromedia.com/software/jrun/?promoid=home_prod_jr_100803
http://www.cvshome.org/
http://www.cvshome.org/
http://subversion.tigris.org/
http://subversion.tigris.org/
http://subversion.tigris.org/
http://prdownloads.sourceforge.net/xins/xins-3.0.exe?download
http://prdownloads.sourceforge.net/xins/xins-3.0.exe?download
http://prdownloads.sourceforge.net/xins/xins-3.0.tgz?download
http://prdownloads.sourceforge.net/xins/xins-3.0.tgz?download
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Functions, types and result codes should use the hungarian naming convention and start with an uppercase.
E.g CheckSt at us, Cust orrer and Not Found.

Parameters, functions, types and result codes starting with an underscore (_") are reserved for XINS.
Parameter names should start with alowercase. E.g: message and houseNunber .

The Java code used for the generated templates and in the examples has private variables starting with
underscore (*_") and contains some comment for the CV S tags. For the rest the Sun Java code conventions
and the Javadoc documentation style rules apply.

Setting up a new project
To create aminimal project with one API containing one function, you need 3 files:
e Xi ns-project.xmn : Thisfile contains the names and properties of the different APIs.
» api . xm :Thisfilecontainsthe declaration of thefunctions, typesand result codes used in your project.

« <functi on nane>. f nc : Thisfile contains the input parameters, the output parameters, the result
codes and some examples of your function.

Xxins-project.xml

 Create anew directory where your APIs based on XINS will be created. For examplec: \ pr oj ect s.
* Createanew xi ns- proj ect . xm fileinthisdirectory with the content :

<?xm version="1.0" encodi ng="UTF-8"?>
<! DOCTYPE project PUBLIC "-//XINS//DTD XINS Project 3.0//EN
"http://ww. Xi ns. org/dtd/ xins-project_3 0.dtd">
<proj ect name="nyproj ects"
rcsversion="$Revision: 1.106 $" rcsdate="$Date: 2013/01/23 10: 00: 59 $"
domai n="com nyconpany" >
</ pr oj ect >

api.xml
Tocreateanew api . xm executein the pr oj ect s directory xins create-api.

The command will ask you for the name and the description of your api. The script will then create a new
api . xm fileinthedirectory api s\ <api nane>\ spec with the content :

<?xm version="1. 0" encodi ng="UTF-8""?>
<I DOCTYPE api PUBLIC "-//XINS//DTD XINS APl 3.0//EN'
"http://ww. Xi ns. org/dtd/api _3_0.dtd">

<api nane="nyproject" rcsversi on="$Revision: 1.106 $" rcsdate="$Date: 2013/01/23 1
<descri pti on>Description of the API.</description>

</ api >

Then the command will ask you if you want to create an implementation of the api. This will create the

skeleton javafile where you will write the code of your function. If you answer yes, anew filei npl . xm
iscreated intheapi s\ <api nane>\i npl directory with the content:
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<?xm version="1.0" encodi ng="UTF-8"?>
<! DOCTYPE inpl PUBLIC "-//XINS//DTD | npl ementation 3.0//EN'
"http://ww. xi ns.org/dtd/inpl_3 0.dtd">

<i npl >
</inmpl>

Finally the command will ask you if you want to define some environments with your api. If you answer
yes, anew fileenvi ronment s. xm iscreated intheapi s\ <api name> directory with the content:

<?xm version="1.0" encodi ng="UTF-8""?>
<I DOCTYPE envi ronnents PUBLIC "-//XINS//DTD Environnents 3.0//EN'
"http://ww. Xi ns. org/dtd/ environments_3 0.dtd">

<envi r onment s>
<environment id="local host" url="http://127.0.0.1:8080/ nmyproject/" />

</ envi ronnent s>

Note

In this guide we will use the xi ns command to create the different files of the project, but it is
also possible to do it manually using atext editor.

If you created the file manually, add the line <api  nanme="nyproject"/> in the xi ns-
proj ect.xm file If the APl hasanimplementation, add the element <i npl / > inthe<api > element
and if it defines some environments add <envi r onnment s/ > in <api >.

MyFunction.fnc

Now that you've created the API definition, we need to define a function within this API.
To create a new function execute xins cr eate-function.

The command will ask you for the name of your api and the name and the description of your function.
The script will then createanew <f unct i on nane>. f nc fileinthedirectory api s/ <api nane>/
spec with the content :

<?xm version="1.0" encodi ng="UTF-8""?>
<IDOCTYPE function PUBLIC "-//XI NS//DTD Function 3.0//EN'
“http://ww. xins.org/dtd/function_3_0.dtd">
<function name="M/Function" rcsversi on="$Revi sion: 1.106 $" rcsdate="$Date: 2013/0

<descri pti on>Description of the function.</description>

</ function>

If the file was created without calling the creat e-functi on target, add the line <f uncti on
nanme="MyFuncti on"/>intheapi . xm file.

Compiling and running the project

Now we have a simple project with a function that, for the moment, does nothing.
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From the specification files XINS can generate :

Foecification documentation.

The specification documentation is a set of static HTML pages containing the description of your
specification. It lists all APIs, functions, types and error codes. The pages also provide an easy way to
call your function using the web application.

A web application.

The web application is packaged as a WAR file that you can deploy in any servlet container. Once the
WAR fileis deployed, you can access your API through HTTP.

The client-side API.

Theclient APl isaJAR file that can be used to invoke remotely the API functions from Java programs.
It features various advanced features, such as load-balancing, fail-over, extensive logging, €tc...

The Javadoc.

The Javadoc contains the definition of the API for the Java classes, including the generated classes. The
javadoc can be generated either for the server side classes or the client side classes.

The HTML specification documentation

To generate the HTML specification documentation (also called specdocs) execute xins specdocs-
mypr oj ect.

Thiswill generate a set of static HTML pages that you can view by opening the filebui | d\ specdocs
\'i ndex. htmi .

The HTML pages contain:

An overview with a description of the different functions, types and error codes used in your API.

A link for each environment to the meta functions _Get Ver si on, _Get Statistics and
_Cet Settings.

For each function, adescription of the input parameters, output parameters, the validation rules and the
possible result codes for this function.

For each function, atest form page to test the function.

For each examplein the function, a description of the URL request, the expected result for this example
and the links to execute the example on the given environments.

For each of the types, a description of the type. If the type is an enumeration, the possible values are
written. If the type is a pattern then the regular expression for the pattern is written along with a link
to test the provided pattern.

The web application.

Create the web application

Theweb application is packaged asaWAR file. When thisWAR file is deployed on the servlet container,
your functions are accessible through HTTP (for example using Internet Explorer).

To create the web application, execute xins war -mypr oj ect.
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This command will createanypr oj ect . war fileinthedirectory bui | d\ webapps\ nyproj ect\.

This target also generates the skeleton file for the implementation, if the file did not exist.
In our example the file will be api s\ myproj ect\i npl\com nyconpany\ nyproj ect\ api

\ MyFuncti onl npl . j ava.

You can set some compilation and running properties by creating abui | d. properti es filein your
project directory and set any of the following propertiesin the file:

Table 1. build.properties properties

Property name

Description

Example

build.compiler

The compiler to useto compilethe
classes. (Defaults to javac)

build.compiler=jikes

build.deprecation

Warn if deprecated methods are
used. (Defaults to true)

build.deprecation=false

build.java.version

The version of Java where the
code will be executed.

build.java.version=1.3

org.xins.server.config

The location to the runtime
properties filee Slash and
backslash in the property value
aretranslated with the system path
separator in XINS. The location
can also bea URL.

org.xins.server.config=../
xins.properties

servlet.port

The port number for the XINS
servlet container (Defaults to
8080).

servlet.port=8181

jmx.port

The port number for JMX
monitoring (Defaults to 1090).

jmx.port=2222

test.environment

The environment upon which the
tests should be executed (Defaults
http://local host:8080/).

test.environment=http://
integration.mycompany.com/
myproject/

test.start.server

Flag to indicate that the API
should be started when the tests
are executed (Defaults to false).

test.start.server=true

Xerces library that produces
sometimes putDocumentinCache
errors.

wsdl.endpoint The endpoint to use in the wsdl.endpoint=http://
generated WSDL file (Defaults|www.mycompany.com/
to the first entry of the/myproject/
envi ronment . xm file)

reload.stylesheet A work around property for|reload.stylesheet=true

These properties can also be passed to the system by using - D<property name>=<property

val ue> on the command line.

Run the web application

To run the web application, execute xins run-mypr oj ect.
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It is adviced to execute the web application with a specified runtime propertiesfile. If no fileis specified,
only the local machine will have access to the API. For more information go to the runtime properties
section.

You can also start the APl using java [-Dorg.xins.server.config=<runtime property file>] -jar
mypr oj ect.war [-port=<port number>] [-gui]. It is not needed to have XINS or Ant installed to run the
API. Therequester or the API or the testers for the API can receive the WAR file and execute it. The -gui
option will start a user interface where the system output will be logged in a console.

To start the WAR fileusing the Jet t y servlet container, create a file named nypr oj ect . xm int the
projects directory with the following content :

<?xm version="1.0" encodi ng="1S0O 8859-1"7?7>

<! DOCTYPE Confi gure PUBLIC
"-//Mrt Bay Consulting//DID Configure 1.2//EN
"http://jetty. nortbay.org/configure_1 2.dtd">

<Configure class="org.nortbay.jetty. Server">

<Cal | name="addLi stener">
<Ar g>
<New cl ass="org. nort bay. http. Socket Li st ener" >
<Set nane="port">8080</ Set >
</ New>
</ Arg>
</Call >

<Cal | name="addWebApplication">

<Ar g>/ nyproj ect/ </ Arg>

<Ar g>bui | d/ webapps/ nmypr oj ect/ mypr oj ect . war </ Ar g>
</Call >

</ Confi gure>

Then dsart java -Dorg.xins.server.config=xins.properties -jar %JETTY_HOME%\start.jar
mypr oject.xml inthe pr oj ect s directory.

Now execute your function by going to the address http://localhost:8080/myproject/?
_function=MyFunction.

As nothing isimplemented in your method, your function will just return a successful result.

If you want to get more information on your function or on XINS run the following meta functions:
« http://localhost:8080/myproject/? _function=_GetVersion

« http://localhost:8080/myproject/?_function=_GetStatistics

« http://localhost:8080/myproject/?_function=_GetSettings

Note

If you want to run the example in tomcat, you need to copy the denp\ bui | d\ webapps
\ mypr oj ect\ nyproj ect. war tothet ontat\ webapps directory and then start tomcat
using the startup script. The URLs to access the functions will then start with http://
| ocal host: 8080/ nyproj ect/.



http://localhost:8080/myproject/?_function=MyFunction
http://localhost:8080/myproject/?_function=MyFunction
http://localhost:8080/myproject/?_function=_GetVersion
http://localhost:8080/myproject/?_function=_GetStatistics
http://localhost:8080/myproject/?_function=_GetSettings
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The server-side Javadoc

To generate the Javadoc on the server-side execute xins javadoc-api-mypr oj ect.

Thiswill generate a set of static HTML pages that you can view by opening thefilebui | d\ j avadoc-
api \ nyproj ect\index. htni .

The client API

To generate the jar file for the client APl execute xins jar-mypr oj ect.
Thiswill generate ajar filelocated at bui | d\ capi s\ myproj ect-capi .| ar.

The following code shows how to use the generated CAPI to call a function. In this example, the
nmypr oj ect API isrunning on the same computer.

i mport org.xins.conmnon. servi ce. Target Descri ptor;

i mport com myconpany. nypr oj ect. capi . CAPI ;
i mport com myconpany. nmypr oj ect. capi . MyFuncti onResul t;

public class Test MyFunction {
public final static void main(String[] args) throws Exception {

/1l Create the descriptor for the service
Tar get Descri ptor descriptor =
new Tar get Descriptor("http://I ocal host: 8080/ nyproject/", 20000);

/1 Create the CAPlI instance
CAPI project = new CAPI (descriptor);

/1 lInvoke the function
MyFuncti onResult result = project.call MyFunction();

/1 No exceptions thown
Systemout.println("Call successful: " + result.getQutputMssage());

}

It's also possible to invoke your APl without using the generated CAPI file but by using the
XI NSSer vi ceCal | er. Examples on how to do it are provided in the XINSServiceCaller Javadoc
[javadoc/org/xing/client/XINSServiceCaller.html].

The generated cal | MyFunct i on method can throw several kind of exceptions. For more information,
refer to the generated CAPI Javadoc. Note that a subclass of the exception could be thrown.
For example, if you want to catch the exception only when the function returns an error code,
catch the or g. xi ns. cli ent. Unsuccessf ul XI NSCal | Except i on which is a subclass of the
org.xins.client. Xl NSCal | Excepti on.

You <can aso cach al the exception a once by catching the class
or g. xi ns. comon. servi ce. Cal | Excepti on.

try {
/1 1 nvoke the function

proj ect.call MyFunction();
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} catch (Unsuccessful XI NSCal | Exception ex) ({
Systemout.println("A standard error occured: " + ex.getErrorCode());
} catch (Call Exception ex) {
Systemerr.println("Execution fail ed:

+ ex. get Message());
}

Most of the time your function will have input parameters to pass to the function. This can be done by
passing the parameters to the callMyFunction method:

i mport com myconpany. nypr oj ect. capi . CAPI ;
i mport com myconpany. nypr oj ect. types. Gender;

MyFuncti onResult result = project.call MyFuncti on(Gender. MALE, "Doe");
or to use the generated MyFunctionReguest object:

i mport com myconpany. nmypr oj ect. capi . CAPI ;
i mport com myconpany. nypr oj ect. types. Gender;

MyFuncti onRequest request = new MyFuncti onRequest ();
request . set Gender ( Gender . MALE) ;

request . set Per sonLast Nane( " Doe") ;

MyFunctionResult result = project.call MyFunction(request);

In the second case, you don't need to call the set method for the optional parametersthat are not set whereas
in the first case you need to pass null values.

A new packageor g. xi ns. cl i ent . async hasbeen addedin XINS 1.4.0. This package providesyou
with some objects which facilitates the call to remote APl asynchronously. For more information, read the
article published at http://xins.sourceforge.net/asynchronous.html.

Asof XINS 1.5.0, it isalso possible to call the API without using the HTTP connection but directly asa
function call. You just need to pass the location of the war file containing the API. As no connection is
involved, the time-out represents the total time-out:

Tar get Descri ptor descriptor =
new Tar get Descriptor("file:///home/ myuser/nyproject.war", 20000);

It is possible to specify the HTTP method to use (POST or GET, default is POST), or whether redirection
returned HT TP code should be followed (default isf al se by using the XI NSCal | Confi g class.

The client-side Javadoc

To generate the Javadoc on the client-side execute xins javadoc-capi-mypr oj ect.

Thiswill generate aset of static HTML pages that you can view by opening thefilebui | d\ j avadoc-
capi \ myproject\index. htn.

The Open Document Format

The Open Document Format [http://en.wikipedia.org/wiki/OpenDocument] is a standard for word
processors documents (similar to .doc). XINS contains a target that can generate the specifications of an
API in this format.

To create the document, execute xins opendoc-mypr oj ect.
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This will generate a bui | d\ opendoc\ nmypr oj ect\ nypr oj ect - specs. odt file than can be
opened with for example Open Office [http://www.openoffice.org/]. Note that Open Officeisfreeand can
save your document as a M S Word document or as PDF.

Implementing the method

For the moment our function has no input, no output and no implementation, we will adapt our previous
project to add a minimum of functionalities.

Defining Input, Output.
Let's add to our project three input fields and a result with one output field.

When you are adding input and output parameters to your function, you should at the same time declare
the type of your parameter. There are two kinds of types, the ones already defined in XINS and the ones
you create. The types already defined in XINS are explained in the next chapter.

To create anew type for your project execute xins create-type.

The command will ask you for the name of the API, the name of the type and the description of the type.
It will then create anew <t ype nane>. t yp file with the content :

<?xm version="1.0" encodi ng="UTF-8""?>
<! DCCTYPE type PUBLIC "-//XINS//DTD Type 3.0//EN'
"http://ww. Xi ns.org/dtd/type_3 0.dtd">

<type name="TypeNanme"
rcsversi on="$Revi sion: 1.106 $" rcsdate="$Date: 2013/01/23 10:00:59 $">

<descri pti on>Description of the type.</description>
</type>
The different possibilities of types that could be defined are listed in the section called “ Defined types’.
Let's create two types for our project, one with the typel ast Nane and one with the type gender .
Edit the Last Narne. t yp filewith

<descri pti on>Last nane of a person.</description>
<pattern>[ A-Za-z ]{1,50}</pattern>

Edit the Gender . t yp with

<descri pti on>A gender. </ descri pti on>

<enune
<i t em nanme="mal e" value="nm" />
<item nanme="femal e" val ue="f" />
</ enune

If the name attribute is not specified it will be the same as the value attribute.

Now that the types are created, we need to add the declaration in api . xnl and to set them as input
parameters in our function. For the output we will use a predefined type so there is no need to define the
typeinapi . xm .
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Add <t ype nane="Gender"/>and <t ype name="Last Nane"/>toapi.xn .
Add tothefile MyFuncti on. f nc :

<i nput >
<par am nane="gender" required="true" type="Gender">
<descri pti on>The gender of the person. </description>
</ par anp
<par am nane="per sonLast Nane" required="true" type="Last Nane">
<description>The | ast name of the person. </description>
</ par anp
</i nput >
<out put >
<par am nane="nessage" required="true" type="_text">
<descri pti on>The nmessage returned to this person. </description>
</ par anp
</ out put >

Y ou can aso assign adefault value for an optional parameter using thedef aul t attribute.

<par am nane="gender" required="fal se" type="Gender" default="ni>
<descri pti on>The gender of the person. </description>
</ par anp

Defining the test environments.

Y ou can specify in XINS the environments where you want to test the API.

As seen in the section called “api.xml”, it's possible create the file containing the test environments by
using the xins create-api or by creating the file with atext editor and editing the xi ns- pr oj ect . xmi .

When you generate the specification documentation, for each function defined in the API alink below
"Test forms® that points you to aHTML form which is used to fill the input parameters of the function.
When you then click on Submit the function will be executed on the specified environment. This requires
of course that the application isinstalled on the defined environment.

The environments are also listed on the main page of the specification documentation along with some
links that provide direct access to some meta functions.

If you want to add a new environment, just add for example <envi r onnent i d="producti on"
url ="http://ww. myconpany. com 8080/ ny-project/" />toenvironnments. xnl.

Defining the examples.

Y ou can also define some examples for your APl in the specification. The definition of the examples are
done in the function specification file.

Let's add some examplesto MyFunct i on. f nc by adding the following text after the out put section:

<exanpl e resul tcode="_I nval i dRequest " >
<descri pti on>M ssi ng paraneter : | astNanme</description>
<i nput - exanpl e nane="gender " >nx/i nput - exanpl e>

</ exampl e>

<exanpl e resul tcode="_I nval i dRequest " >
<descri pti on>l nval i d paraneter</description>
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<i nput - exanpl e nane="gender " >nx/i nput - exanpl e>

<i nput - exanpl e nane="per sonLast Nane">Bond 007</i nput - exanpl e>
</ exampl e>
<exanpl e>

<descri pti on>Message returned. </ descri ption>

<i nput - exanpl e nane="gender " >f </ i nput - exanpl e>

<i nput - exanpl e nanme="per sonLast Nane" >Lee</i nput - exanpl e>

<out put - exanpl e nane="nessage">Hel |l o M ss Lee</ out put - exanpl e>
</ exampl e>

This example shows how to add some examples to afunction with i nput and out put parameters but
it's also possible to define examples for a function that contains a data section or returns a result code
that contains some parameters. For more information, look at the function specification defined in the
al | i none project.

The examples are shown on the generated specification documentation and if you have a so defined some
environments, you can execute the example by just clicking the provided links.

In XINS 1.4.0, you can create an example using xins create-example. The API should be running on

http://|ocal host:8080/<api name>/. The create-exampletarget will ask you for the name of the APl and the
request URL. The example is automatically added to the function.

Implementing your function.

You can edit the new MyFuncti onl npl . j ava generated file located in the api s\ nypr oj ect
\'i mpl \ com nyconpany\ nmypr oj ect\ api directory with

public final Result call (Request request) throws Throwabl e {

String nom nation = null;
i f (request.getGender().equal s(com myconpany. myproj ect.types. Gender. MALE)) {

nom nation = "M ster";
} else {
nom nation = "M ss";
}
Successful Result result = new Successful Result();
result.set Message("Hello " + nomination + " " +request. get PersonLast Nane());

return result;

}
Executing your function

We first need to rebuild the WAR file, the spec docs, the client jar and the javadoc by executing xins all-
mypr oj ect.

Now you must restart the servlet container server and reopenthefilebui | d\ specdocs\i ndex. ht mi .

You can test your function by either clicking on the link provided with the examples or by using the test
forms.

The error code

An error code (previously named result code) contains the description of an error that occurred when
executing the implementation code.
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When you generate the specification documentation, you can already notice that some error codes already
exist by default. These error codes are returned by the system when the problem occurs.

Y ou should create custom error codes whenever the implementation of your function would encounter an
error condition that should be distinguishablefor the caller. For example, if you connect to another service,
if you perform 1/O operations or if the input fields should match fields in a database.

We will now extend our example with aNoVowel error code. Note that this error could be also detected
by improving the | ast Nane pattern.

Create a error code by executing xins create-rcd.

The command will ask you for the name of your api and the name and the description of your error code.
The script will then create a new NoVowel . r cd file in the directory <specsdi r >/ <api nane>
with the content :

<?xm version="1.0" encodi ng="UTF-8""?>
<I DOCTYPE resultcode PUBLIC "-//XINS//DTD Result Code 3.0//EN'
"http://ww. Xi ns. org/dtd/resul tcode 3 0.dtd">

<resul t code nanme="NoVowel "
rcsversi on="$Revi sion: 1.106 $" rcsdate="$Date: 2013/01/23

<descri pti on>The nane does not contain any vowel s. </description>

</resul t code>

Once thisfile is created, add the line <r esul t code name="NoVowel " /> intheapi . xnl file
A reference to this error code also needs to be defined in the function that may return this error code. In
our case MyFuncti on. f nc. Also add theline<r esul t code-ref name="NoVowel " /> atthe
beginning of the out put section of MyFuncti on. f nc.

Now we need to adapt our Java codeto detect if the given last name does not include any vowelsand return
the error code when it isthe case. Add the following code at the beginning of your cal | () method.

String | ast NameLower = request. get PersonLast Nane().toLower Case();

10: 00: 59 $"

if (lastNaneLower.indexOF("a') == -1 && | ast NaneLower.indexOh('e') == -1 &&
| ast NameLower . indexOf ("i') == -1 && | ast NameLower.indexOF('o") == -1 &&
| ast NameLower . i ndexOf ("u') == -1 && | ast NaneLower.indexOr('y') == -1) {

return new NoVowel Result ();

}

Now we need to adapt the specification of your function to include this result code in the examples. We
moved the example 3 to example 4 as we wanted to keep the order "unsuccessful results" "successful
results’ in our examples and we added the example 3 with

<exanpl e resul t code="NoVowel| ">
<descri pti on>The name does not contain any vowels. </description>
<i nput - exanpl e nane="gender " >f </ i nput - exanpl e>
<i nput - exanpl e nane="per sonLast Nane" >qgsl kfj </ i nput - exanpl e>

</ exampl e>

You can now regenerate everything with xins all-myproject and after restarting the servlet container
server, test the new example using the generated specification documentation.

It is possible to have parameters and a data section in the error code. To doit, add an out put element to
the error code. For the examplesin the specification and setting the valuesin the implementation, just do it
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as you would do for afunction with output parameters or data section. Theal | i none example contains
aAl readySet error code with one parameter.

Since XINS 1.4.0, it is possible to specify if an error code is functional or technical. Functional error code
are error that may occur such as| nval i dPasswor d where as technical errorsindicate a problem such
asDat abaseCor r upt ed. By default an error code istechnical. To specify the error code as functional
add the attributet ype="f unct i onal " tother esul t code element.

If you want to reuse an error code aready defined in another API, you don't need to copy thefile. You can
also point to the error code of the API. Its uses the same system as in the section called “ Shared types’.

XINS aso has predefined error code that are returned when something went wrong.

Table2. XINS defined error code

Error code Description

_DisabledFunction The function is currently disabled.

_Interna Error There was an internal error.

_InvalidRequest Indicates that the reguest is considered invalid
since it does not match the criteria defined by the
specification.

_InvalidResponse Indicates that the implementation produced a

response that does not match the criteria defined by
the specification. Typical callers should treat this
like aninterna error.

_DisabledFunction The function is currently disabled.

_DisabledAPI The AP is currently disabled.

_FunctionNotSpecified Indicates that the request does not contain which
function should be called.

_FunctionNotFound Indicates that the function of the request does not
exist.

_InvalidRequestFormat Indicates that the input format is invalid for the
calling convention.

_NotAllowed Indicates that the user is not alowed to call the
function.

The runtime properties

You may want to add some flexibility to your application by changing a property without needing to
recompile the code or restarting the server. This way you can distribute the same WAR file of your web
application to different places. Y ou can think at the following situations:

A filelocation may differ on the computers on which you want to deploy your application.

» Thelocation of a database may differ depending on whether you want to test your application or deploy
it in a production environment.

* A username/password which you don't know the value and should be entered by the administrator.

* A link to another XINS service, in case of a distributed environment.
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» Youwould like to adjust settings that influence performances.
* Youwould like to adjust the debugging level.

The properties for your APIs are defined in the runtime properties file often named
Xi ns. properti es. This file location is passed to the application server with the system property
org. xi ns.server.config.

To sart the WAR file using the XINS servlet container, just execute Xxins -
Dorg.xins.server.config=xins.properties run-myproject. You can aso set the location of the
xins. propertiesinthebuil d. properti es andthen execute xinsrun-mypr oject.

Note

If you want to run the example in tomcat, you need to add in the file t ontat \ conf
\catalina.properties the line org.xins.server.config=c:\\Program
Fi | es\\ xi ns\\ deno\\ xi ns. properties.

Example of runtime propertiesfile:

#

# Ceneral XINS properties

# Check configuration file every 60 seconds
org. xi ns. server.config.rel oad=60

# Access rul es
org. xi ns.server.acl =all ow 127.0.0.1 *;

# Loggi ng properties
org. xi ns. | ogdoc. | ocal e=en_US

An exampleis aso provided in the deno\ xi ns. properti es file
It's a'so possible to define a different runtime property file for each API you are running on the servlet

container. To define a specific runtime property file for an API, use org.xins.server.config.<api name>
instead of org.xins.server.config.

The properties
Some properties defined in this file are already interpreted by the system:

Table 3. xins.propertiesruntime properties

Property name Required Description Example

org.xins.server.config.relpad, defaults to 60. Interval in seconds for|org.xins.server.config.rel pad=60
check the xins.properties
file for any changes.

org.xins.server.acl no, defaultsto localhost. |Access rules for the|org.xins.server.acl=allow
functions 127.0.0.1 *; \
adlow  192.168.0.0/24
MyFunction
org.xins.server.acl.<api |no Access rules for the|org.xins.server.acl.myproject=allow
name> functions of the specified| 127.0.0.1 *; \
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API. The specified rules
are executed before the
generic one.

deny 192.168.0.0/24
MyFunction

org.xins.server.config.incnde A comma separated list|org.xins.server.config.incdude=../
of runtime property files|default-xins.properties
to include. The files
should use relative paths.
org.xins.logdoc.locale |no, defaultstoen US. | Thelocale to be used for | org.xins.logdoc.locale=en_US
the logging messages.
org.xins.server.jmx no, false by defaullt. Enables the management | org.xins.server.jmx=true
of the APl using
IJMX (Java Management
eXtension).
org.xins.server.contextl Difitigal | typesof contextID| The regular expression|org.xins.server.contextl Difilter=[a-
are accepted by default. |pattern for the expected|zA-Z]{5}
format of the context
ID. If the context ID is
invalid, anew onewill be
generated.
org.xins.server.logging.iniho, true by default Initialize the logdoc|org.xins.server.logging.init=false
logging
org.xins.server.contextl D| pasttirue by default Push the contextI D to the| org.xins.server.contextl D|push=false
NDC
org.xins.logdoc.stack TracedtM eefapiiseved  false|Flag indicating that the|org.xins.logdoc.stackTraceAtM essagel eve
meaning that the stack|exception stack trace
traces are logged at|{should be logged at
DEBUG level. the same level as the
message.
log4j.* no, defaultsto console. |Logging properties used|logdj.rootL ogger=DEBUG,
to adapt the debug level,| console
formatting or output to
your needs.
log4j.<api no, defaults to|Root logger for the|logdj.myproject.rootL ogger=INFO,
name>.rootL ogger log4j.rootLogger. specified API. logfile_myproject

Getting properties

value

Now we will adapt the xi ns. properties for the MyFuncti on implementation by adding the

following lines:;

# Sal utation nessage for the person

salutation=Hell o

We now need to change the implementation to read and use the property. Note that the property should be
able to be changed at runtime. Add the following codeto MyFunct i onl npl . j ava

Xins.
Xins.
Xins.
Xins.

i mport
i mport
i mport
i mport

org.
org.
org.
org.

comon
common.
common.
common.

.col l ections. M ssi ngRequi redPr opert yExcepti on;
col l ections. I nvalidPropertyVal ueExcepti on;
manageabl e. Boot st r apExcept i on;

manageabl e. I nitializati onExcepti on;
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/**
* The sal utation nessage.
*/

private String _salutation;

protected void initlnpl (Map<String, String> properties)
t hrows M ssi ngRequi redPr opertyExcepti on,

I nval i dPr opertyVal ueExcepti on,

Initializati onException {

/1 CGet the salutation

_salutation = properties.get("salutation");

if (_salutation == null || _salutation.trim().equals("")) {
t hrow new M ssi ngRequi r edPr opertyException("sal utation");

}

/1 Here you can al so chack the value and throw an
/1 1nvalidPropertyVal ueException if needed

}

public final Result call (Request request) throws Throwabl e {

result.set Message(_salutation + " " + nomnation + " " +
request . get Per sonLast Nane()) ;
return result;

}

Now recompile your code, restart the server, execute the function, change the vaue in
Xi ns. properti es toHi,waitfor the server to rel oad the properties fil e and execute the function again.

The API class defines adei ni t | npl () method. This method is used to release resources when you
stop the API.

Note

When the xins.properties file has changed, only the i ni t I npl () method is invoked. The
dei ni t I npl () iscaled only when you stop the servlet container.

The API class has a boot st rapl npl 2( Map<String, String> buil dSettings) method
that is called the API is started. The buildSettings passed as parameters are the properties stored in the
web. xm fileincluded in the deployment war file.

The APl class has a reinitializelnpl () method. This method can be invoked in your
implementation to ask the framework to reinitialize the API.

Defining properties

XINS 1.3.0 includes a new system that allows to define runtime properties that you will use in your
APl inthei npl . xm file. In this file you define the name of the property, its description, its type and
whether is property is required or optional. The value of the property still needs to be defined in the
Xins. properti es file.

Example:
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<i npl >
<runti me-properties>
<property nanme="nmyproject.eurodollar.rate" type="_float32" required="true">
<description>The price in dollars of 1 euro.</description>
</ property>
</runtine-properties>
</inmpl>

Now when the specification documentation is generated, a new page is available containing the list of the
runtimes properties used by the APl along with their description, their type and whether the property is
required or optional. This page makes it easier to deploy an API with the correct runtime properties set.

Another advantage of defining the propertiesthisway is that you don't need to implement thei ni t | npl
method to retreive the property values. A classis generated that checks and retreives the properties. If the
value of a property isincorrect or arequired property is missing then the API will fail with a description
of the problem. Theget API () . get Properti es() method can aso be called from thei ni t | npl
method of your function, if you want for example initialize another object based on a runtime property.

Example on how to use the generated class:

/1 No inmports needed, no initlnpl nethod needed

public final Result call (Request request) throws Throwabl e {
Successful Result result = new Successful Result();
result.setPricel nEuro(request.getPricelnDollar() /
((RuntinmeProperties) getAPI().getProperties()).getMyprojectEurodollarRate
return result;

}

If the property was optional, aj ava. | ang. Fl oat object would have been returned.

The bootstrap properties

The bootstrap properties are the properties defined in the generated web. xml file. These properties
cannot be modified at runtime. You can view the properties by caling the calling the meta function
_CGet Set ti ngs. Whenthe WAR fileis created XINS set some default properties which are:

org.xins.api.name The name of the API.

org.xins.api.build.version The version of XINS with which the WAR filewas
created.

org.xins.api.version The version of the APl (may be empty).

org.xins.api.build.time The time at which the WAR file was created.

org.xins.api.calling.convention The name of the default calling convention.

Y ou can a'so define your own properties. Just add <boot st r ap- pr operti es>and <boot st r ap-
property> elementstothei nmpl . xm file.

Example:

<i npl >
<boot strap- properti es>
<boot strap-property nane="xiff.| ogi n. page" >Logi n</ boot st r ap- property>
<boot strap-property nane="xi ff.defaul t.conmand" >Def aul t Conmand</ boot st r ap- prop
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</ boot st rap- properti es>
</inmpl>

Note

Bootstrap properties starting with org.xins. ae reserved except for the
org. xi ns. server. confi g bootstrap property. This property could be set to indicate the
location of the runtime properties file in the case that you cannot passit in the command line of
the Servlet container.

The values of the properties will be available in the boot st rapl npl (Map<String, String>
boot st rapProperti es) method of your functions and shared instances.

Note

Since XINS 2.2 it isalso possible to defineini npl . xm extra XML elements you want to add
tothe generated web. xm file. Tou canthink at elementssuchascont ext - paramfil ter,
listener,..

To doit, use the following syntax (after runtime-properties):

<i npl >
<web- app el enent ="cont ext - par ani' >
<! [ CDATA[
<par am nane>cont ext Confi gLocat i on</ par am nane>

<par am val ue>/ V\EB- | NF/ appl i cati onCont ext . xm , / VEB- | NF/ daoCont ext . xm </ par

11>
</ web- app>
<web-app el enent="listener" id="spring">
<! [ CDATA[

<l i stener-cl ass>org. spri ngfranmewor k. web. cont ext . Cont ext Loader Li st ener</1i st

11>
</ web- app>
</inpl>

Integration with CVS / Subversion

As you've probably already noticed al of our specification files have r csver si on="$Revi si on
$" and r csdat e="$Dat e$" when the files are stored in a control version system such as CVS, the
$Revi si on$ is replaced by something like $Revi si on 1.2 $ and $Dat e$ with something like
$Dat e 2006/ 11/ 13 15:16: 47 $. Thisis particularly useful when you want to keep track of the
version and the date of the last changes of the specification.

XINS allows you also to freeze the different parts of the specification. This is particularly useful if the
person or department using the APl is not the same as the one designing it or implementing the API.
This way the different parties can assume the required input or output parameters. If for some reasons a
function or a type changes, the specification documentation would mark the function or type in red with
atag "broken freeze".

To freeze a function, a type or aresult code add the attribute freeze next to the name in api . xm . The
value of this attribute should be the version of the frozen specification.

For example

<api nane="nyproject" owner="johnd"
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rcsversion="$Revi sion: 1.106 $" rcsdate="$Date: 2013/01/23 10:00:59 $">
<function nane="M/Function" freeze="1.3" />

<type nanme="CGender" freeze="1.1" />
<type name="Last Name" />

<resul tcode nane="NoVowel " freeze="1.2" />
</ api >

You can aso specify inthe xi ns- pr oj ect s. xm theroot of the cvsweb location:
<cvsweb href="http://cvs. nyconpany. com cvsweb/ nyproj ects" />

If this element is provided, broken freeze will provide you with a link where you will be able to see the
changes done for thisitem since it has been frozen. If you usevi ewcvs only thefirst provided link will
work.

Managing dependencies

For advanced APIs, you would probably need to use some external libraries or to use other services. This
can be done by adding dependencies to your API.

InXi ns- proj ects. xm youcanadd an attributedependenci esdi r toindicateinwhich directory
the jar files used by your project will be included. For example

<proj ect name="nyproj ects"
rcsversion="$Revi sion: 1.106 $" rcsdate="$Date: 2013/01/23 10: 00:59 $"
dependenci esdi r="../ ot her-projects"
domai n="com nyconpany" >

</ proj ect >

Inapi s\ <api >\i npl \'i npl . xm you add the jar files needed for your project using the dependency
element. For example

<i npl >
<dependency dir="utils" />
<dependency dir="capis" includes="project2-capi.jar" />
<dependency dir="spring" includes="spring.jar" deploy="false" />
</inpl>

In the previous example when your implementation will be compiled the following jar fileswill bein the
classpath: . . \ ot her-projects\utils\*.jar;..\other-projects\capis\project2-
capi.jar;..\other-projects\xins\xins-client.jar. These fileswill also be included
in the generated WAR file except for spring.jar. Thisdepl oy attribute has been introduced in XINS 2.2.

An example of dependenciesis provided in XINS with thefi | t er edpr oj ect demo. This APl cals
another APl (myproject) using CAPI.

Note

The order of the elementsin theimp.xml isimportant, if the elements are not in the correct order
thevaidation of i npl . xm with the DTD will fail.

The order is | ogdoc, boot strap- properti es, runti ne-properties,
content, dependency, calling-convention, instance.
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Adding other files to the WAR file

It is possible to add any kind of files to the WAR file. Thisis particulary useful if you want to deploy a
web site at the same time as your API.

Todoit add content elements to the impl.xml file. Note that you'll need to also add aweb- pat h attribute
to the impl element because the API is by default mapped with the root path. So in order to accessthe file
you have added to the WAR file, you will need to associate the APl with another path.

Example:

<i mpl web- pat h="store">
<content dir="apis/petstore" includes="xslt/*.xslt" />
<content dir="apis/petstore/web" includes="*.htm *.js" />
<content dir="apis/petstore/web" includes="*.jpg" web-path="imges" />

</inmpl>
Note

If you only want to add files to the WEB- | NF directory, for example to use them in your API,
then you don't need to specify theweb- pat h attribute to the i npl element.

Multiple implementations and stubs

XINS can support multiple implementations for the same API. To add a new implementation for the API
add inthexi ns- proj ects. xm ani nmpl element with anane attribute to the api. For example

<proj ect name="nyproj ects”
domai n="com nyconpany" >
<api nane="al |l i none">

<iml />
<i mpl name="nystub" />
</ api >

</ proj ect >

New targets are created for this implementation. Only server side targets (war, javadoc-api, run, ...) are
created for this new implementation. The other targets only depend on the specification which doesn't
change. The new target syntax is <acti on>-<api nane>-<i npl enentati on nane>. For
exampl e to compile the new implementation of the exampl e above execute xins classes-allinone-mystub.

Note

Thelist of the API names with the possible implementation is printed at the end of the execution
of the xins help command.

Having the possibility to have more than one implementation is useful when you want to create a stub
(fake API) so that other systems can test the API before being implemented.

XINS offers the possibility to generate a stub implementation of the API. The stub is generated based on
the examples defined in the function specification.

To generate the stub implementation execute xins stub-<api name>-<implementation name>. Then the
stub file are generated in the directory api s\ <api nane>\i npl - <i npl enmentati on nane>
\ <package nane>. You can also edit the generated code, for example to be more flexible with some
input parameters or to return other values. Note that the stub target won't replace existing files.
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Testing

XINS offers different ways to test your API.

The first way is using the generated test forms or the links provided with the examples on the function
page of the generated specdocs.

XINS offers also the possibility to test the API using the JUnit library. XINS will generate the unit test
based on the examples defined in the functions specification. To be ableto test your API proceed asfollow:

* Addat est element totheapi elementinthexi ns-proj ects. xm . For example:
<proj ect nane="nyproj ects"

domai n="com nyconpany" >
<api nane="al |l i none">

<inpl />
<test />
</ api >

</ pr oj ect >
* Runthe API. For example: xinsrun-allinone.
» Executethe test target. For example: xinstest-allinone.

The test target will generate the unit tests in the directory api s\ <api nane>\t est\ <package
nane>. Themain test case executed iSAPI Test s. j ava whichincludesthefunction tests. One example
matches one test.

The generated unit tests are editable. Y ou can adapt it to better fit the expected result or to add your own
unit tests. Note that the test target won't overwrite filesif thet est directory already exists.

The result of the unit tests is located in the directory bui | d\t estresul t s. Results are provided
in XML and HTML. The XML contains the configuration settings and the logs generated. The HTML
contains the results of the test in a more human readable format.

To be ablefor the test target to work correctly, you haveto copy thej uni t . j ar filelocatedinxinsl i b
directory to thel i b directory of ant.

The test target also have an option to run the APl before starting the tests. To use it, add
test.start.server=true tothebuil d. properties. If this option is set, you don't need to
execute the xins run-<api name> command.

If you want to execute the tests on another environment than you local machin, you can specify it in the
bui | d. properti es by setting the propertiest est . envi r onment .

Note

The <t est /> element should be added after the <i npl /> and <envi ronnents />
elementsif defined.

Categories

Sometimes an API can contains a lot of functions. It become then more difficult to find the function in
the specdocs. XINS 1.3.0 introduced the notion of categories. With categories you can specify functions
that belong together.
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Example:
Define the category names at then end of api . xnd :
<api nane="al |l i none" >

<cat egory nane="Dat aSections" />
</ api >

Then create a category file with the name <cat egory nane>. cat . Thisfile will define the function
that are in the same group.

Example Dat aSect i ons. cat:

<?xm version="1.0" encodi ng="US- ASCI | " ?>
<! DOCTYPE cat egory PUBLIC "-//XINS//DTD Category 1.3//EN' "http://ww. Xxins.org/dtd
<cat egory nane="Dat aSecti ons" >
<descri ption>Data section related functions. </description>
<function-ref nanme="DataSection" />
<function-ref name="DataSection2" />
<function-ref name="DataSection3" />
</ cat egory>

Now if you regenerate the specdocs, The categories will appear at the top of the API page. Y ou can then
more easily find the function you wanted.

Managing logs
XINSincludesit's own logging system called logdoc which is based on log4;.

Managing the logs on the server side.

Y ou can aso manage the debugging settings of XINS by changing the xins.properties file. Here are the
main logging settings that can be changed:

Table 4. Log4j properties

Property Vaue examples Description

log4j.rootLogger DEBUG, console, logfile Indicates the level of logging and
the modules that will receive the
output.

log4j.<api name>.rootL ogger INFO, logfile2 Indicates the level of logging and

the modules that will receive the
output for the specified API.

|og4j.appender.console org.apache.logdj.ConsoleAppenderindicates where the output is
redirected for the module.

log4j.appender.consol e.layout org.apache.logdj.PatternLayout | Indicatesthe pattern for the output
header (text that precedes the
output text).

l0g4j .appender.consol e.layout. Condedlorbiatiec/ox - %om%n Indicates the format of the output
header.
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log4j .1ogger.org.xins.common.expiBRRAR Changes the log level for a
message. This can be useful if you
want to hide a message or if you
want to show a message.

Thelog levelsare DEBUG< | NFO< NOTI CE < WARN < ERROR < FATAL. This meansthat if you set the
log level to ERROR, only the ERROR and FATAL messages will be logged.

For more information on the possible characters in the conversion pattern, visit the log4j website [http://
logging.apache.org/logdj/docs/api/org/apache/l ogdj/PatternL ayout.html].

The nested diagnostic context (NDC - %x) is set to the value of the _cont ext parameter of the query. If
no_cont ext parameter ispassed adefault contextiscreated asapi Name@ ocal Host : yyyyvMid-
HHMESNNN: r andomwhere:

» apiNameisthe name of the API.
* locaHost isthe IP address of the computer that is running the api.

* yyyyMMdd-HHmmssNNN is the date of the request (year - month - day - hour - minute - second -
millisecond).

» random isab digits long random hexadecimal generated number.

For moreinformation on the possiblelogging properties and values, visit log4j documentation page [ http://
logging.apache.org/logdj/docs/manual .html].

Adding your own logs.

It's sometimes useful to log events that may happen in your function. To do so, you need to create what
is called alogdoc (log documentation).

To create anew logdoc execute xins create-logdoc.

The command will ask you for the name of your api. The script will then create anew | og. xmi filein
the directory api s\ <api nane>\i npl with the content:

<?xm version="1.0" encodi ng="UTF-8"?>
<! DOCTYPE | og PUBLIC "-//XINS//DTD XI NS Logdoc 2. 3//EN'
"http://ww. xi ns.org/dtd/log_2_3.dtd">

<l og>
<transl ati on-bundl e | ocal e="en_US" />

<group id="exanpl ei d* name="Exanmpl e">
<entry id="10000" | evel ="DEBUG' >
<descri pti on>Exanpl e of | ogdoc with sone paraneters. </description>
<par am nane="paraneter” />
<par am nane="nunber" nul | abl e="fal se" type="int32" />
</entry>
<entry id="10001" |evel ="ERROR' exception="true">
<descri pti on>Exanpl e with an exception. </ descri ption>
</entry>
</ group>
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</l og>

The  group id is used for the crestion of the  log key (eg.
com nycompany. nyproj ect . api . exanpl ei d. 10001) and the group name is used for the
description of the group.

It also creates adefault trandation filet r ansl at i on- bundl e- en_US. xnl with the content:

<?xm version="1. 0" encodi ng="UTF-8""?>
<I DOCTYPE transl ati on-bundl e PUBLIC "-//XINS//DTD XINS Transl ati on Bundl e 2. 3//EN'
"http://ww. Xi ns. org/dtd/transl ati on-bundle_2 3. dtd">

<transl ati on- bundl e>
<transl ation entry="10000">Exanpl e of |ogdoc with the paranmeter <val ue-of-param
<transl ation entry="10001">Exanpl e of an exception.</transl ation>

</transl ati on-bundl e>

You can now use the logdoc in your function implementation by caling the method
Log. | og_10000( myParam 36);

The command will also add the element <| ogdoc / >totheimpl element of thei npl . xm file. If you
want to use thelogsin packages other than the default one add the attributeaccessl evel =" publ i c"
tothel ogdoc element.

The Logdoc consist of amain | og. xm file which defines the possible locale for the logs of this API
and the groups of entries. Each entry has an i d that is by convension a number higher than 10000 as
numbers between 1000 and 9999 are reserved for XINS. Ids don't have to be consecutive numbers. It's
even advisable to have numbers gaps between groups.

If the entry has the attribute excepti on with the value t r ue, then the exception should be
the first parameter when invoking the method. For example the id 10001 should be invoked with
Log. | og_10001( myException);.

The possible types for a parameter arebool ean, i nt 8,i nt 16,i n32,i nt 64,t ext and obj ect .
By default for a parameter the nullable attributeis set to t r ue and the type attributeissettot ext .

These types match respectively in Java the types bool ean, byt e, short,int,l ong, String and
hj ect .

If you use logdoc in your API, the list and the description of the defined log entries will be available in
the specification documentation.

Inthel og. xm thewarninglevel issetwith| evel =" WARNI NG' but thelevel istranslated asthe WARN
log4j level.

Note that when the specification documentation (specdocs) is generated the HTML pages describing
the logging message is also generated. You can see the XINS logdoc at http://xins.sourceforge.net/
logdoc.html.

Configuring the properties files for specific logs

Sometimestoo much log informationisprinted and you would like to remove some of the messages printed
by the log.

There are several waysto do this. The best ways isto hide the logging messages you don't want.
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The following example will hidethe HTTPCl i ent DEBUGIogs:

| og4j . 1 ogger. org. apache. htt p=I NFO

The following example will hide all XINS messages which are not at least at the WARN level:

| og4j . 1 ogger. org. xi ns=WARN

The following example will hide the specific logging message because the message is at DEBUG level:
| og4j .1 ogger.org. xins.server.lifespan.init.3402=] NFO

The locale can also be specified in the XINS properties file:

# Local e used for |o0gging
org. xi ns. server. | og. | ocal e=en_US

Thelogdoc with thelocaleen_US and f r _FR are provided in XINS.

An example of a XINS properties file with a customized logging system can be found in the deno
directory.

Managing load balancing and fail over

XINS can also manage load balancing and fail over when you want to invoke your function using CAPI.
To do so, your function needs to be started on 2 computers. Our code is based on the CAPI example done
in the section called “The client API”.

The first possibility would be to use the G- oupDescri pt or (javadoc [javadoc/org/xing/common/
service/GroupDescriptor.html]) instead combined with a Tar get Descr i pt or (javadoc [javadoc/org/
xins/common/service/ TargetDescriptor.html]):

/1l Create the descriptor for the service

Target Descri ptor serverl = new TargetDescriptor("http://192.168.0.20: 8080/ ny-proje
Tar get Descri ptor server2 = new TargetDescriptor("http://192.168.0.21: 8080/ ny-proje

Descriptor[] servers = {serverl, server2};

/] Create the descriptor for |oad bal ancing

GroupDescri ptor descriptor = new G oupDescriptor (G oupDescri pt or. RANDOM TYPE, serv

/* 1f you wanted to have fail over replace the above Iine with

GroupDescri ptor descriptor = new G oupDescri ptor (G oupDescri ptor. ORDERED TYPE,

The drawback of this method is that it's not flexible, any changes of | P addresses, time-out or if you want
to add a new server, you would need to adapt the code, recompile and then redeploy it.

A better method would be to have the URL s and the time-out in a property file. The only code you need
then to create your descriptor is

/1 Build the descriptor

Descri ptor descriptor = DescriptorBuil der.build(properties, "capis.nyproject");

where propertiesisthe Map<St ri ng, St ri ng> object that contains your parameters.
If you only have one server (for example your computer for testing), set the properties as

capi s. nmyproj ect=service, http://127.0.0.1: 8080/ ny-project/, 20000
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If you want to have load balancing, set the properties as

capi s. myproj ect =group, random serverl, server2
capi s. nmyproj ect.serverl=service, http://192.168.0.20: 8080/ ny-project/, 20000
capi s. nmyproj ect.server2=service, http://192.168.0.21: 8080/ ny-project/, 20000

If you want to have fail over, set the properties as

capi s. nyproj ect =group, ordered, serverl, server2
capi s. nyproj ect.serverl=service, http://192.168.0.20: 8080/ ny-project/, 20000
capi s. nyproj ect.server2=service, http://192.168.0.21: 8080/ ny-project/, 20000

It's possible to combine load balancing and fail over. For example in the following code the invocation is
balanced between serverl and server2 and if one of both is down back-up will be used.

capi s. nyproj ect =group, random systeml, systen®

capi s. myproj ect.systeml=group, ordered, serverl, back-up

capi s. myproj ect.systenR=group, ordered, server2, back-up

capi s. nyproj ect.serverl=service, http://192.168.0.20: 8080/ ny-project/, 20000
capi s. nyproj ect.server2=service, http://192.168.0.21: 8080/ ny-project/, 20000
capi s. myproj ect. back-up=service, http://192.168.0.22: 8080/ ny-project/, 20000

Thefail-over isnot alwaysexecuted when an error occur, the condition upon which thefail-over isexecuted
arelisted in the XINSServiceCaller Javadoc [javadoc/org/xing/client/XINSServiceCaller.html].

XINS types

the section called “ Defining Input, Output.” shows you an example on how to use the types when defining
the function.

Predefined types.

XINS has some integrated types which facilitate the use of input and output parameters with the
implementation.

Table 5. XINSintegrated types

type Java representation Example

_text javalang.String hello world

_boolean boolean true

_int8 byte 25

_int16 short 2004

_int32 int 15

_int64 long 654654132135544566

_float32 float 256

_floate4 double 3.14159

_date org.xins.common.types.standard. D 2@dah 1<

_timestamp org.xins.common.types.standard. Ti206te6: VS0

_property Map<String, String> upgrade3Dtrue¥26surname
%3Dde%2BHaan
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_list org.xins.common.types.standard.Ljiiseviala26item2%026item1

_set org.xins.common.types.standard. SetevizBle26item1%26item?2
_base64 byte(] aGVshG8=

_hex byte]] 546573746f

_url String http://www.google.com
_descriptor org.xins.common.service.Descri ptatescriptor=group, random,

targetl, target2

descriptor.targetl=service,
http://127.0.0.1:8080/my-
project/, 8000

descriptor.target2=service,
http://192.168.0.1:8080/my-
project/, 8000

_xml org.xins.common.xml.Element | <firstName>Alain</firstName>

You can find an example using all these types in the function deno\ xi ns- proj ect\ api s
\'al i none\ spec\ Si npl eTypes. f nc.

Defined types

As seen in the section called “Defining Input, Output.”, it's also possible to define your own type. Here
isalist of the possible typesto definein XINS:

<pat t er n>: This type accepts a PERL5 regular expression and allows you to define a text that has
some constraintsin its format.

<enun: This type must contain alist of <i t en® elements, each item element must have aval ue
attribute that contains the value of the item and can have anane attribute that contains the description
of theitem. If the name is not defined it's set by default to the value of the item.

<i nt 8>, <i nt 16>, <i nt 32>, <i nt 64>: These types define a number. They accept the optional
attributes m n and max that can be used to set a minimum and a maximum value for the parameter.

<fl oat 32>, <f | oat 64>: These types define a floating point number. They accept the optional
attributes m n and max that can be used to set a minimum and a maximum value for the parameter.

<properties>: Thistypeissimilar tothe property typebut it allows you to specify atype for
the keys and the values of the property by using the optional attributes naneType and val ueType.
If not specified thetype t ext will be used.

<l i st > and <set >: These types are used to define a list of values in a parameter. The type of the
value can be restricted by using the optional attribute t ype. If not specified the default value for the
t ype attributeis_t ext.

<xml>: Thistypeis used to specify an XML paramter. It accept the attribute xsdLocat i on that can
beaURL or alocd fileinthe spec directory.

<baseb64>, <hex>: Thistype defines abinary. They accept the optional attributesmi n and max that
can be used to set a minimum and a maximum size in bytes for the binary.
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You can find an example using some of these types in the function deno\ xi ns- proj ect\api s
\'al I i none\ spec\ Defi nedTypes. f nc.

Shared types

If you have more than one API, you may want to reuse types defined in other APIs (for example EMail .typ,
Account.typ, LastName.typ, ...). Instead of copying thefileto the new API, you can aso point to thistype.
Thisisdone by using <api nane>/ <t ype name> inapi.xml and in the function(s) specification.

For example:

<type nanme="petstore/EMail"/>

<par am nane="out put EMai I " required="fal se" type="petstore/ EMail">
<descri pti on>An exanpl e of output shared type. </description>
</ par anp

Grouping types

Param combos

It'salso possiblein XINSto defined agroup of i nput or out put parameters. There are4 kinds of group:
e inclusive-or

If agroupisi ncl usi ve- or then at least one of the parameters defined in the par am r ef should
have avalue.

» excl usi ve-or

If agroup isexcl usi ve- or then one and only one of the parameters defined in the par am r ef
should have avalue.

e all-or-none

If agroup isal | - or - none then either none of the of the parameters defined in the par am r ef
should have avalue or all.

e not-all

If agroupisnot - al | then at least one of the parameters defined in the par am r ef should not have

avalue.
Example:
<i nput >
<param nanme="birthYear" required="fal se" type="_int32">
<description>The birth date's year.</description>
</ par anp
<param nanme="bhi rt hMont h" required="fal se" type="_int32">
<description>The birth date's nonth. </description>
</ par anp
<param nanme="bhirthDay" required="fal se" type="_int32">
<description>The birth date's day. </description>
</ par anp
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<par am nane="bi rt hCountry" required="fal se" type="_text">
<descri pti on>The country where the person is born.</description>
</ par anp
<param nane="birthC ty" required="fal se" type="_text">
<description>The city where the person is born.</description>
</ par anp
<par am nane="age" required="fal se" type="Age">
<descri pti on>An exanple of input for a int8 type with a m ni mum and maxi num </
</ par anp
<l-- One of the two paraneters nmust be filled but not both -->
<par am conbo type="excl usi ve-or">
<paramref name="birthYear" />

<paramref name="age" />
</ par am conbo>
<I-- At least one of the two paraneters nmust be filled -->

<par am conbo type="incl usi ve-or">
<paramref name="birthCountry" />

<paramref name="birthGCty" />
</ par am conbo>
<l-- These paraneters nust be filled together or not filled at all -->

<par am conbo type="all-or-none">
<paramref name="birthYear"” />
<paramref name="birthMnth" />
<param ref name="bi rt hDay" />
</ par am conbo>
</i nput >

If the conditionisnot met, XINSwill returnaresult withan _| nval i dRequest error codeif therequest
does not match the input par am conbo or an _| nval i dReponse error code if the result does not
match the output par am conbo.

Y ou can find an example using the groups in the function deno\ xi ns- pr oj ect\ api s\ al | i none
\ spec\ Par anmConbo. f nc.

Attribute combos

It is also possible to defined similar constraint on attributes of elements defined in the data section (See
next chapter). Thisisdoneusingtheat t ri but e- conbo andtheattri but e-r ef elements.

Example:

<dat a>
<cont ai ns>
<cont ai ned el enent =" person” />
</ cont ai ns>
<el enent name="person">
<descri pti on>A person</descripti on>
<attribute name="birthCountry” required="fal se" type="_text">
<descri pti on>The country where the person is borned. </description>
</attribute>
<attribute name="birth-city" required="fal se" type="_text">
<description>The city where the person is borned. </description>
</attribute>
<attribute name="age" required="fal se" type="Age">
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<descri pti on>An exanple of input for a int8 type with a m ni mum and maxi nrum
</attribute>
<l-- At least one of the two attributes nust be filled -->
<attribute-conmbo type="inclusive-or">
<attribute-ref nane="birthCountry" />
<attribute-ref nane="birth-city" />
</attribute-conbo>
</ el ement >
</ dat a>

Combos based on values

It is aso possible to define constraints based on the value of one parameter (and not only on whether the
parameter is set or not). This is done by added the value attribute to the param-ref element or attribute-
ref element for attribute-combo.

Example:

<i nput >
<param nanme="sal utation" required="true" type="Sal utation">
<descri pti on>The gender of the person. </description>
</ par anp

<par am nane="nai denNanme" required="fal se" type="_text">
<descri pti on>The mai den nane. </ descri pti on>
</ par anp
<l-- If the salutation is Madam the naiden nanme is required -->

<par am conbo type="incl usive-or">
<paramref name="sal utation" val ue="Madam' />
<par am ref name="rmai denNanme" />
</ par am conmbo>
</input>

The description of the type associated with the param-combo is then a bit different:
* inclusive-or

If the parameter has the defined value then the second parameter is required.
* excl usive-or

If the parameter has the value then the other parameter should not be filled, otherwise the second
parameter is required.

e all-or-none

If the parameter has the value then the others parameters are required, otherwise the other parameters
should not be set.

* not-all
If the parameter has the value then the other parameters should not be set.

For a better understanding, look at the Par amConboVal ue. f nc function provided intheal | i none
API.

It is also possible to have more than one par am r ef with avaluein the same par am conbo.
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The data section.

The data section defines a tree structure in the input or output section.

The specification

Example:

<dat a>
<cont ai ns>
<cont ai ned el ement =" property" />
</ cont ai ns>
<el enent name="property">
<descri pti on>A property name and val ue. </ descri ption>
<attribute name="name" required="true" type="PropertyName">
<descri pti on>The property nane. </ description>
</attribute>
<attribute name="val ue" required="true" type="_text">
<descri pti on>The property val ue. </ descripti on>
</attribute>
</ el ement >
</ dat a>

An element can also contain another element or text(pcdata) but not both.
To add an element in another element, add

<dat a>
<cont ai ns>
<cont ai ned el ement =" property" />
</ cont ai ns>
<el enent name="property">
<descri pti on>A property name and val ue. </ descri ption>
<cont ai ns>
<cont ai ned el enent =" product” />
</ cont ai ns>
<attribute name="nanme" required="true" type="PropertyName">
<descri pti on>The property nane. </description>
</attribute>
</ el ement >
<el enent name="product">

If you want your element to contain PCDATA, use

<dat a>

<cont ai ns>
<cont ai ned el ement =" property" />

</ cont ai ns>

<el enent name="property">
<descri pti on>A property name and val ue. </ descri ption>
<cont ai ns>

<pcdata />

</ cont ai ns>
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<attribute name="nanme" required="true" type="PropertyName">
<descri pti on>The property nane. </ description>
</attribute>

Since XINS 1.1.0, it's also possible to include more than one element in the data section:

<dat a>
<cont ai ns>
<cont ai ned el enent =" packet" />
<cont ai ned el enent="letter" />
</ cont ai ns>
<el enent nanme="packet">
<descri pti on>The packet. </descripti on>
<attribute nanme="destination" required="true" type="_text">
<descri pti on>The destination of the packet.</description>
</attribute>
</ el emrent >
<el ement nanme="letter">
<description>The | etter.</description>
<cont ai ns>
<pcdata />
</ cont ai ns>
<attribute nanme="destination" required="true" type="_text">
<descri ption>The destination of the letter.</description>
</attribute>
</ el emrent >
</ dat a>

Attributes can also have a default value using the def aul t attribute.

The implementation

Thedatasectionistranslated into a Javaobject with the appropriate set methods. Oncethe object iscreated,
you can add them to the Successf ul Resul t using provided add methods.

Example:

Successful Result result = new Successful Result();
Property nmyProperty = new Property();

nmyPr operty. set Name( myNane) ;

nyProperty. set Val ue(nyVal ue);

resul t.addProperty(nmyProperty);

return result;

If you had specified that your element could contain another element, the Pr opert'y class would also
haveaaddPr oduct ( Pr oduct) method.

If you had specified that your element could contain a text, the Pr operty class would also contain a
pcdat a( St ri ng) method.

The result

To view what kind of result to expect from a data section, we will define an example in the specification
of the function.
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<out put - dat a- exanpl e>
<el enent - exanpl e name="property">
<attri but e- exanpl e name="nane" >upgrade</ attri but e- exanpl e>
<attribute-exanpl e name="val ue">true</attri bute-exanpl e>
</ el ement - exanpl e>
<el enent - exanpl e name="property">
<attri but e- exanpl e name="nane" >sur nane</ attri but e- exanpl e>
<attribut e-exanpl e name="val ue">Doe</ attri but e- exanpl e>
</ el ement - exanpl e>
</ out put - dat a- exanpl e>

The resulting XML from XINS would then be

<result>

<dat a>
<property nane="upgrade" val ue="true" />
<property nane="surnanme" val ue="Doe" />

</ dat a>

</result>

If your element accepted PCDATA, you can set avalue by adding <pcdat a- exanpl e>My val ue</
pcdat a- exanpl e> beforethe<at t ri but e- exanpl e>.

Y ou can find some examples of the output data section in the functions deno\ xi ns- proj ect\ api s
\'al I i none\ spec\ Dat aSecti on. fnc and deno\ xi ns- proj ect\api s\al | i none\ spec
\ Dat aSect i on2. f nc.

Data section for the input

Since XINS 1.1.0it's also possible to send a data section for the request. The definition of the data section
is similar to the definition for the output section except that it must be done in the input section. The
definition of the example is done using the <i nput - dat a- exanpl e> element.

This alows you to send complex structures with XINS in the request.

The framework will generate some extra objects and methods to get the values of the input data section.
Hereisan example:

i mport java.util.lterator;

Iterator itAddresses = request.listAddress().iterator();

whil e (itAddresses. hasNext()) {
Request . Addr ess next Address = (Request. Address) it Addresses. next();
System out . pri ntl n( next Addr ess. get Post code());

}

An exampleis provided with XINSin the function deno\ xi ns- pr oj ect \ api s\ al | i none\ spec
\ Dat aSect i on3. f nc.

Since XINS 1.5.0, if you are using Java 1.5 and deploying on a Java 1.5 application server, you can also
benefit from the Java generics feature as demontrated at the end of the next section.

Data section on the client side

On the client side the data section is retreived as an or g. xi ns. conmon. xm . El enent object
(javadoc [javadoc/org/xins/common/xml/Element.html]). To get the values in the returned data section,
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use the methods provided in the El enent classsuchasget Attri bute(String | ocal Nane) or
get Chi | dEl emrent s(String nane).

If you want to send a data section as input, you will need to create an
org. xi ns. conmon. xnl . El enent (javadoc [javadoc/org/xing/common/xml/Element.html]) for
example by using the or g. xi ns. cormon. xnl . El ement Bui | der (javadoc [javadoc/org/xing/
common/xml/ElementBuilder.html]) class. Then you can pass this object to the CAPI call method or to
the generated Request object.

Since XINS 1.3.0, the methods and objects are also generated on the client side for the data section. They
are generated the same way asthey are on the client side. For example, if you want to send alist of address
and receive alist of properties, thiswill look like this:

* For therequest:
i mport com myconpany. myapi . capi . MyFuncti onRequest ;

MyFuncti onRequest request = new MyFuncti onRequest();

MyFuncti onRequest . Address addressl = new MyFuncti onRequest. Address();
addr essl. set Conpany(" MDo");

addressl. set Post code("12345");

request . addAddr ess(addressl);

» For theresult:

inmport java.util.lterator;
i mport com nmyconpany. myapi . capi . MyFuncti onResul t ;

MyFunctionResult result = capi.call MyFunction(...);
Iterator itProperties = result.listProperty().iterator();
while (itProperties.hasNext()) {
MyFuncti onResul t. Property nextProperty = (M/FunctionResult. Property) itProperti
String propertyNane = nextProperty. get Nane();
String propertyVal ue = next Property. getVal ue();
Systemout. println(propertyNane + ": " + propertyVal ue);

}

If you are using Java 1.5 or higher and did not set the build.java.version property to a lower version,
the generated classes will use the generics feature added to the Java language since Java 1.5. This will
simplified your code of using the code:

i mport com nmyconpany. myapi . capi . MyFuncti onResul t;

MyFunctionResult result = capi.call MyFunction(...);

for (MyFunctionResult.Property nextProperty : result.listProperty()) {
String propertyNane = nextProperty. get Nane();
String propertyVal ue = next Property. getVal ue();
Systemout. println(propertyNane + ": " + propertyVal ue);

}

Function accesses

XINS includes a way to set some permissions for the functions using ACLs and also a way to disable/
enable afunction.
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ACLs

The ACLs are used to restrict the access of a function based on the IP address from where the request
comes.

The ACLsaredefined inthe xi ns. properti es filewith the org.xins.server.acl property

The value is a dot comma separated list of the keywords al | ow or deny, the IP addresses specified as
ACL alowed or denied to access the function and the name of the function or * used for al functions.

An ACL isan IP address followed by / and the number of bits that should remains the same. For example
192. 168. 0. 0/ 24 defines al IP addresses starting with 192. 168. 0.

Example:

org. xins.server.acl =allow 127.0.0.1 *; \
al l ow 192. 168. 0. 0/ 24 MyFuncti on

Per default, if an |P addressisnot specified in thelist then the accessisdenied. If an 1P addressis specified
twice then the first rule will apply. If you specify / O after an IP address then all |P address will match.

Example:

org.xins.server.acl=allow 127.0.0.1 *; \
deny 192.168.0.21 GCetSettings; \
allow 192.168.0.21 *; \
allow 192.168.2.0/24 *; \
allow 0.0.0.0/0 _GetVersion; \
al l ow 192. 168. 0. 0/ 24 MyFuncti on

In thisexample, | P addresses starting with 192.168.0. will be ableto accessMyFunct i on, the IP address
192.168.0.21. will also be able to access the meta functions except the _Get Set t i ngs meta function.
All IP addresses starting with 192.168.2. will be able to access the meta functions. Everybody will be able
to accessthe _Get Ver si on metafunction.

Since XINS 1.1.0, the keyword f i | e is also accepted with as second argument the location of the file
containing the permissions. The specified file should be of a specia format. The lines should start with
allow, deny or file. If theline start with allow or deny it should befollowed by the ACL and the function as
shown in the previous example. If the line starts with file, it should be followed by the location of another
acl premission file. Empty lines, lines containing only spaces and lines starting with # are ignored. The
ACL files will be monitored for changes every or g. xi ns. server. confi g. r el oad seconds and
will be reloaded when the meta function _Rel oadPr operti es isinvoked.

Example:

org. xi ns.server. acl =al |l ow 194. 134. 168. 0/ 24 _*;\
file /usr/conf/myApp. acl

nyApp. acl :

al | ow 194. 134. 168. 0/ 24 *
deny 194.134.32.0/24 _*
al | ow 194. 134.32. 0/ 24 *

# comment. ..
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al l ow 212.129. 129. 120 Cet Key

Since XINS 2.1, it is possible to alow or deny a call based on the calling convention used. To do it add
after the name or the pattern of the function, the name or the regular expression pattern of the caling
convention you want to allow or deny.

For example:

org. xi ns.server. acl =al | ow 194. 134. 168. 0/ 24 _* _xins-std| _xins-xslt;\
deny 0.0.0.0/0 _*;\
deny 0.0.0.0/0 * _xins-soap

allows the meta functions to be called only using the xins-std or _xins-xslt calling conventions for the
given IPrange and denies any call using the _xins-soap calling convention.

Enable/Disable a function

It's also possible to enable or disable afunction. By default all functions are enabled.

To disable a function, request the following URL: http:// APl _PATH?
_function=_D sabl eFuncti on&f uncti onName=MyFunct i on

To re-enable the function, reguest the URL: http:// APl _PATH?
_functi on=_Enabl eFuncti on&f uncti onNane=MyFuncti on

The links to enable or disable a function are provided on the test form generated with the specification
documentation.

HTTPS

It's also possible to use HTTPS as communication layer to call a XINS API. To do it, you just need to
configure the HTTP server (such as Apache) or the servlet container (such as Tomcat) with the correct
settings.

For more information on setting up the server, read the following articles:

 Configuring Tomcat 4.0 to use HTTPS [http://www.dga.co.uk/customer/
publicdo.nsf/0/2B4063F90912CC5D85256CB00007888B ?OpenDocument]

e Tomcat 4.0 SSL configuration How-To [http://jakarta.apache.org/tomcat/tomcat-4.0-doc/ssl-
howto.html]

» How can | support HTTPS (SSL) in a servlet? [ http://www.jguru.com/fag/view.jsp?EI D=53931]

Note that HTTPS is a supported protocol on the client side only since XINS 1.3.0.

The meta functions

When you're starting a XINS server, a set of meta functions are already available. We just saw in the
Enable/Diable section thefirst two _Di sabl eFuncti on and _Enabl eFunct i on. Notethat all meta
functions start with an underscore.

Table 6. XINS Meta functions

Name Description
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_NoOp No operation: This meta function does nothing but
maybe useful to monitor if the server isup or down
or the response time of the server.

_GetVersion Get the running version of xml-enc, XINS, Javaand
of the API if defined.
_GetSettings Returns the properties as set in the runtime

property file and the Java properties as returned by
System get Properties().

_GetStatistics Returns the amount of memory used and for
each function, the number of successful call, and
unsuccessful call with the response time (min, max,
last, average).

This function may have aparameter r eset =t r ue
that performs a reset of the statistics at the same
time.

This function may aso have a parameter
det ai | ed=t r ue that displays the statistics per
error code for the unsuccessful resullts.

_ResetStatistics Resets the statistics.

_ReloadProperties Reloads the XINS propertiesfile.

_CheckLinks Checks that the API can access the other API's or
URL it'susing.

This meta function will test the URLs set in the
runtime propertiesfile wherethe property is defined
in the i npl . xm file with the type _url or

_descriptor.

_GetFunctionList Returnsthe list of the functions.

_DisableFunction Disables the function passed in the functionName
input parameter.

_EnableFunction Enables the function passed in the functionName
input parameter.

_DisableAPI Disables the APl by returning HTTP 503 to all
requests.

_EnableAP Re-enables the API that was disabled.

_WSDL Returns the WSDL [http://www.w3.org/TR/wsdl]
of the API.

_SMD Returns the Simple Method Description [http://

dojo.jot.com/SMD] of the API.

Management

As XINS APIs are standard Servlets, most of the management can be done by the Servlet container or
the J2EE application server. Most of the management specific to the APl is done by editing the runtime
property file. See.
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JMX

JMX MBeans have been added since XINS 1.5.0 to have the possibility to manager the API using standard
management tools sush as HP Openview or the JConsol e included in the JDK.

The following information are available through the IMX interface:

o Statistics

» Bootstrap properties

* Runtime properties

» XINSversion running

* APl version

 Startup time

* Thelist of the functions

Y ou can a'so perform the following actions:

» noOp(): Function that does nothing but can be used to check if the API is up.

* reloadProperties(): Reload the runtime properties.

LogdJHi er ar chyDynani cMBean isaso registered as M Bean.

The object names used for both MBeans startswith or g. xi ns. server. <api hame>.
By default, IMX isdisabled. To enableit set the runtime property org.xins.server.jmx=true.

To have an overview execute xins run-myproject with Java 1.5 or later and run the j consol e. exe
located inj dk\ bi n.

Versioning

Y ou can also set aversion to your API.

To set the API version create a . ver si on. properti es file in the project directory with the 2
following properties defined: ver si on. maj or andver si on. ni nor.

The version will be apply to all APIs. If you want a specific version for one of the API, create a
.version. propertiesintheapi s\ <api name> directory.

Shared instance

In XINS the functions areinitialised when you start the server, the initialisation also passes the properties
definedinxi ns. pr oper ti es tothefunction. XINS hasthe notion of shared instance which isan object
created and initialized in a similar way as functions are. Furthermore this object is passed as an instance
to all the defined functions of the API.

Y ou can think about the following situations:

* You want to access a database or an access to LDAP with the access properties set in
Xi ns. properties.
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* You want to share data between functions.

To add a shared instance to the APl add in the inpl.xm file <instance
nane="_sharedObj ect" getter="get SharedCbj ect" class="SharedCbject" />.

Now you need to create a class Shar edCOhj ect in the implementation package that extends
the or g. xi ns. cormon. nanageabl e. Manageabl e class (javadoc [javadoc/org/xins/common/
manageable/M anageable.html]).

Now you could use this object by calling in the call(Request request) method

/1l Get some data fromthe shared object
String firstName = _sharedbj ect. get Fi r st Nane(request. get Last Nane());

Anexampleisprovidedintheal | i none project.

Calling Convention

Since version 1.0.1, XINS has the notion of calling convention.

A calling convention specified the format of the request and the format of the result. You can seeit asa
communication protocol.

XINS 1.1.0 includes the following calling conventions: _xi ns- st d, _xi ns-ol d and_xi ns-xni .

XINS 1.2.0 includes the _xi ns- xsl t calling convention and allows to define it's own custom calling
convention.

XINS 1.3.0includesthe _xi ns- soap and _xi ns- xm r pc calling conventions.

XINS 1.4.0 includes the automatic detection of the calling convention meaning that if no _convention
parameter is sent and no custom calling convention is defined, XINS will try to detect the calling
convention to call based on the format of the request.

XINS 1.5.0 includes the XINS front-end calling convention: xinsff. A front-end framework user guide
[frontend/index.html] isalso included in the release. It is also possible since this version possible to define
the supported HT TP methods for a custom calling convention. This can be useful if you want to define a
REST [http://en.wikipedia.org/wiki/REST] calling convention. A new example was also added that uses
aMul ti partCal lingConventi on to receive binariesfiles.

XINS 2.0 includes the _xi ns-j son and _xi ns-j sonr pc caling conventions. The xi ns-ol d
calling convention has been removed in this release.

XINS 2.1 includesthe _xi ns- soap- map calling convention.

How to define the calling convention

If nothing is specified the standard calling convention (asin XINS 1.0.0) is used.

If the calling convention can be set, by adding the _convent i on parameter to the URL with the value
of the calling convention as argument.

The default calling convention for an API can bespecifiedinthei npl . xml fileby addingthecal | i ng-
convent i on element. For example:

<i npl >
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<cal | i ng- conventi on nane="_xins-xm" />
</inmpl>

Standard calling convention

The standard calling convention or also named POX-RPC calling convention is the default calling
convention used by xins. If no caling-convention is included in the i npl.xm file and no
_convent i on parameter is passed in the request, XINS will expect an request using this convention and
return aresult using this convention. The property value for the POX-RPC calling conventionis_Xi ns-
st d. This calling convention is also known as the standard calling convention.

This examples provided in this document are using the POX-RPC calling convention. The examples
generated with the specdocs and the test forms are a so using this calling convention.

A document (link [protocol/index.html]) isalso provided inthedocs\ pr ot ocol directory that contains
the specifications of this calling convention.

XSLT calling convention

The property value for the XSLT calling convention is _xi ns-xsl t. The request is similar to the
standard calling convention (using URL). The result returned is the result of the processing of the XML
normally returned with the standard calling convention with a specified XSLT file. This means that the
result could beaHTML page or XML or plain text or binary depending on the XSLT transformation.

The location of the XSLT stylesheets is set using the runtime property tenpl at es. <api
nanme>. xi ns- xsl t. sour ce. Thisproperty refersto the directory wherethe XSL T stylesheets can be
found. The stylesheets then must have the name of the function with the. xsl t extension.

Y ou can also pass the location of the template in the request with the _t enpl at e parameter. This will
override the previous runtime property. Thelocation should be relative to the path or URL specified in the
runtime property t enpl at es. <api nane>. xi ns-xsl t. paranet er. prefi x. If this property
isnot set the _t enpl at e parameter is not allowed.

The XSLT calling convention caches the templates for better performances. You can clear the cache by
passing the _cl eart enpl at ecache=t r ue parameter. Y ou can aso disable the cache by setting the
t enpl at es. cache runtime property tof al se.

SOAP calling convention

The property value for he SOAP calling convention is _xi ns- soap. The SOAP caling convention
allows you to cal the APl using SOAP. SOAP is a W3C [http://www.w3.0rg/TR/soap/] standard
communication protocol for Web Services. The SOAP calling convention allows to provide to external
software and companies a way to communicate using a standard protocol. The SOAP calling convention
allows also to use XINS with WS-BPEL [http://www.0asi s-open.org/committees/wsbpel/charter.php] or
JBI [http://java.sun.com/integration/].

Example of an input request:

<?xm version="1.0" encodi ng="UTF-8""?>
<soap: Envel ope xm ns: soap="http://schemas. xm soap. or g/ soap/ envel ope/" xm ns: ns0="u
<soap: Body>
<nsO0: Dat aSect i on3Request >
<i nput Text >Hel | o</ i nput Text >
<dat a>

43


protocol/index.html
protocol/index.html
http://www.w3.org/TR/soap/
http://www.w3.org/TR/soap/
http://www.oasis-open.org/committees/wsbpel/charter.php
http://www.oasis-open.org/committees/wsbpel/charter.php
http://java.sun.com/integration/
http://java.sun.com/integration/

XINS User Guide

<addr ess company="MDo" postcode="1234" />
<address company="Drill" postcode="4567" />
</ dat a>
</ ns0O: Dat aSect i on3Request >
</ soap: Body>
</ soap: Envel ope>

SOAP is often associated with a WSDL file that describes the Web Service. XINS can generate this
WSDL file by executing xins wsdl-<api name>. This generated file is located in the directory bui | d
\ webapps\ <api >. Note that the generated WSDL file also contain the XML Schema for the standard
types, the defined types, the required fields or the optiona fields. By default the endpoint defined in
the WSDL is the first environment defined in the environment XML file or if there is no file defined
http://1 ocal host/ <api name>/?_convention=_xi ns-soap. You can set the endpoint
by passing the command line argument - Dansdl . enpoi nt or by setting the wsdl.endpoint property in
bui | d. properti es file. You can then use this generated file in the Web Services client sush as C#,
Visua Basic, PHP, Perl.

The SOAP calling convention and the generation of the WSDL have been developed based the WS-
| Basic Profile Version 1.1 [http://www.ws-i.org/Profiles/Basi cProfile-1.1-2004-08-24.html]to ensure
better compatibility with other frameworks.

XML calling convention

The property value for the XML calling convention is_xi ns- xm . In this case only HTTP POST are
accepted. The returned output isthe same as the standard calling convention. Example of an input request:

<request function="functi onName">
<par am nane=" par anNane" >par anVal ue</ par an
<dat a>
<product name="sonet hi ngl" price="12.2" />
<product name="sonet hi ng2" price="23.5" />
</ dat a>
</ request >

XML-RPC calling convention

The property value for the XML-RPC calling convention is _xi ns-xm rpc. XML-RPC is a
specification used to remote procedure call using XML over HTTP. XML-RPC has client frameworksin
alot of languages including AppleScript, 2ME, Ruby.

Example of an input request:

<?xm version="1.0"7?>
<nmet hodCal | >
<nmet hodNane>Si npl eTypes</ net hodNane>
<par ans>
<par anp<val ue><st r uct ><nenber >
<nane>i nput Bool ean</ nane>
<val ue><bool ean>0</ bool ean></ val ue>
</ menber ></ st r uct ></ val ue></ par anv
</ par ans>
</ met hodCal | >

For more information on XML-RPC, visit the web site at http://www.xmlrpc.com/.
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JSON-RPC calling convention

The property value for the JSON-RPC calling convention is _xi ns-j sonrpc. JSON-RPC is a
specification used to remote procedure call in different Ajax frameworks such as the DOJO toolkit. The
specification of JSON-RPC arelocated at http://json-rpc.org/wiki/specification. Both specification version
(1.0 and 1.1) are supported by the JSON-RPC calling convention.

Example of an input request for JSON-RPC 1.0:

{"method": "ResultCode", "parans": ["Hallo"], "id": null}

Examples of ouput result for JSON-RPC 1.0:

{"result": {"outputTest": "Hallo"}, "error": null, "id": null}

{"result": null, "error": "AlreadySet", "id": null}

Example of an input request for JSON-RPC 1.1:

{"version": "1.1", "method": "ResultCode", "parans": {"inputText": "Hallo"}}
http://ww. myserver. com pat h/ Resul t Code?i nput Text =Hal | 0

Examples of ouput result for JSON-RPC 1.1:

{"version": "1.1", "result": {"outputTest": "Hallo"}}

{"version": "1.1", "error": {"nane": "AlreadySet", "code": 123, "message": "The pa
For more examples, visit the web site at http://json-rpc.org/.

The automatic detection of the matching calling convention for arequest will only find request using the
1.1 specifications.

XINS also support JISON-RPC 2.0. The property value for the JSON-RPC calling convention is_xi ns-
j sonr pc2. The specification of JISON-RPC 2.0 are |located at http://www.jsonrpc.org/specification.

Example of an input request for JSON-RPC 2.0:

{"jsonrpc": "2.0", "method": "Echo", "parans": { "in": "test 123" }, "id": 4}
Examples of ouput result for JSON-RPC 2.0:

{"jsonrpc":"2.0", "result":{"out":"test 123"}, "id":4}

{"jsonrpc":"2.0", "error":{"code":-32000, "nessage":"The paraneter has already bee

JSON calling convention

The property value for the JSON calling convention is _Xi ns-j son. This calling convention is based
on the Yahoo! JSON protocol specified at http://devel oper.yahoo.com/common/json.html. This includes
the support for the callback parameter.

Example of an input request:
http://ww. myserver. com pat h/ Resul t Code?i nput Text =Hal | o&out put =j son
Examples of ouput result:

{"out put Test": "Hallo"}
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Example of an input request with callback:

http://ww. myserver. com pat h/ Resul t Code?i nput Text =Hal | o&out put =j son&cal | back=proce
Examples of ouput result with callback:

process({"outputTest": "Hallo"})

This calling convention could be useful if you want to call the API from GWT [http://code.google.com/
webtoolkit/] (Google Web Toolkit).

SOAP-MAP calling convention

The property valuefor the SOAP-Map calling conventionis_xi ns- soap- map. Thiscalling convention
accepts SOAP requests and applies the same mapping for the request or the response as what is done in
the xins wsdl-to-api command.

Thismeansthat if you need to write aweb service using a pre-defined WSDL, you can do it by executing
xi ns wsdl -to-api command and pass _conventi on=_xi ns- soap- map in the URL query
parameters.

The calling convention will copy the Envelop and Body XML elements as what received in the
request, try to keep the same namespaces prefix and map data element attributes to sub-elements. If
after the transformation not all parameters are detected and mapped correctly, you can also extend the
org.xins.server.SOAPMapCallingConvention and implement you own parsing on specific parts or create
your specific response.

Custom calling convention

To create  your own calling convention, you need to extend the
org. xi ns. server. CustonCal | i ngConventi on class (javadoc [javadoc/org/xing/server/
CustomCallingConvention.htmi]).

This class has two abstract methods, conver t Request | npl and convert Resul t | npl , that you
must implement.

Notethat the Cust ontCal | i ngConvent i on extendsthe Manageabl e class, thismeansthat you can
read the bootstrap settingsintheboot st r apl npl method and the runtime propertiesinthei ni t | mpl
method.

To define the calling convention in the i npl . xm , you need to add an extra argument cl ass to the
cal I i ng- convent i on element. For example:

<i npl >
<cal | i ng- conventi on nane="my-convention" class="com myconpany. nyproj ect.M/Conven
</inpl>

Y ou can also define more than one calling convention, in this case one calling convention must have the
atribute def aul t ="t rue".

Example:

<i npl >
<cal | i ng- conventi on nanme="_xins-std" default="true" />
<cal | i ng- conventi on nanme="my-convention" class="com myconpany. nyproj ect. M/Conven

</inmpl>
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More information on how to create your own calling convention is provided in the calling convention
primer [http://xins.sourceforge.net/ccprimer.html].

You can aso look a the fileupload APl provided in the examples that defines a
Cust onCal | i ngConvent i on in order to upload binariesfiles.

Examples calling convention

Severa custom calling conventions are provided in the examples. Some of them are not included in the
core libraries so if you want to use them, you will need to copy the file to your project.

Hereisalist of the custom calling convention used in the examples:

e MultipartCallingConvention isdefinedinthefil eupl oad API. This calling convention
alowsto receive files according to the HTTP file upload protocol. This calling convention requiresthe
commons-fil eupl oad. j ar includedinapi s\ fi |l eupl oad\ | i b directory.

 RESTCal | i ngConventi on isdefinedinther est API. Thiscalling convention only accepts strict
REST [http://en.wikipedia.org/wiki/Representational_State Transfer] requests.

* The pet st or e example uses the Fr ont endCal | i ngConventi on which is a custom caling
convention added to the core. More information about this calling convention can be found in the XINS
Front-end Framework manual [frontend/index.html].

Utility classes

XINS aso contains in the org.xins.common package, a set of classes that could be useful for the
implementation of your API.

Note also that the following APIs are distributed with al XINS applications: HTTPCore [http://
hc.apache.org/httpcomponents-core-ga/index.html], HTTPClient [http://hc.apache.org/httpcomponents-
client-ga/index.html], commons logging [http://jakarta.apache.org/commons/logging/], commons
codec [http://jakarta.apache.org/commons/codec/], Logdj API [http://logging.apache.org/logdj/docy
index.html], json [http://www.json.org/javalindex.html], logdoc [https://github.com/znerd/logdoc], and
xmlenc [http://xmlenc.sourceforge.net/]. Y ou can then use these APIs without adding any dependency
elementinthei npl . xm file.

 Spec package

The spec package is located in org.xins.common.spec (javadoc [javadoc/org/xins/common/spec/
index.html]). This package contains classes that provide information on the specification of the API.
Y ou can get the specification from the client side by using capi . get API Speci fi cati on() and
from the server side using api . get APl Speci fi cati on() . The method will return a APl Spec
object from which you will be able to get all the specification of the API. Y ou can get information sush
asthelist of the functions, the type of a parameter in afunction, the error code returned by a function.

e HTTPServiceCaller

The org.xins.common.http.HTTPServiceCaller (javadoc [javadoc/org/xins/common/http/
HTTPServiceCaller.html]) isaclassthat isused to get information from aURL. This class also supports
|oad-balancing and fail-over via the GroupDescriptor such as the XINSServiceCaller does. This class
has a call method that requires a HTTPCallRequest as input where you can specify the method to
call the URL, the parameters of the URL and the behaviour for the fail-over, and this call returns a
HTTPCallResult where you can get the returned text as String, byte[] or as InputStream as well asthe
HTTP code returned.
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» ExpiryFolder

The  org.xins.common.collections.expiry.ExpiryFolder ~ (javadoc  [javadoc/org/xins/common/
collections/expiry/ExpiryFolder.html]) class allows you to store some properties (key & value pairs) for
alimited amount of time. When a property is added, it has the maximum time to live. If the property is
not requested during this time then the property is removed. If the property is requested using the get()
method then time to live of this property is set again to the maximum.

The ExpiryFolder is particularly interesting if you want to implement caching of the result. More for
look at the online article [http://xins.sf.net/resultcaching.html] explaining how to do result caching for
amethod.

e BeanUtils

The org.xins.common.BeanUtils (javadoc [javadoc/org/xins/common/BeanUtils.html]) class allows to
copy the properties of a POJO to another POJO. It can useful to fill a generated Request object on the
client side or a SuccesfulResult object on the server side. Especialy if you use libraries such as JPA
(Java Persistence API) or the Spring Framework. It is also useful when you want to forward a request
or when the result of afunction call should be used as input to call another function.

If the names of the properties are different, you can also provide a mapping of the properties name as
parameter, element name or attribute name. The method will also convert the types whenever possible.

» FilewWatcher

The org.xins.common.io.FileWatcher (javadoc [javadoc/org/xins/common/io/FileWatcher.html]) class
alowsyouto monitor afilefor changes. Y ou just need to specify thefileto monitor, theinterval between
two checks of the file and the listener that will be notified when the file has changed. Don't forget to
invoke the start() method to start the monitoring of thefile.

» ElementList

The org.xins.common.xml.ElementList (javadoc [javadoc/org/xins/common/xml/ElementList.htmi])
class allows you to list and get sub DOM elements of a DOM element. As described in the Javadoc,
this class has several advantages over NodeList.

* Optimized classes

The org.xins.common.text (javadoc [javadoc/org/xins/common/text/URLEncoding.html]) package
contains classes for URL encoding, URL decoding or creation of regular expression patterns.

Ant tasks

Before using the tasks, you need to define them using the following lines:

<property environnent="env" />
<t askdef resource="org/xi ns/comon/ant/antlib.xm" classpath="${env. XINS_HOVE}/ b

callxins task

Thecal | xi ns task isused to call axins API. The result of the call isthen stored in properties.
Example:

<cal | xi ns function="M/Function"
api Locati on="http://|ocal host: 8080/ nyproject/"
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prefix="myapi ">
<par am nane="gender" val ue="ni" />
<par am nane="per sonLast Nane" val ue="Lee" />
</ cal | xi ns>

This task will call the MyFunct i on function of the nypr oj ect API. The result will be store in the
myapi.message Ant property as MyFunct i on just returns one output parameter named nessage.

Thepr ef i x attributeis optional.

If the function returns a data section, the properties will be set as described in the Ant XML property task
[http://ant.apache.org/manual/CoreT asks/xmlproperty.html].

xins task

The xins task is used to execute axins target. If the specifications have changed this target will take care
of recreating the build.xml and calling the requested target.

If you execute the script from another directory, you will need to define the pr oj ect di r optiona
attribute.

Example:
<xi ns api ="nyproject" target="specdocs" />
Note that the api attribute is optional:

<xins target="create-api" />

XINS targets

Hereisadescription of the most useful targets.

Table7. XINStargets

Target name Description

run-<api> Runs the WAR for the API.

war-<api> Createsthe WAR for the API.

specdocs-<api> Generates all specification documentation for the
API.

javadoc-api-<api> Generates Javadoc APl documentation for the API.

server-<api> Generates the war file, the Javadoc API
documentation for the server side and the specdocs
for the API.

jar-<api> Generates and compiles the Java classes for the
client-side API.

javadoc-capi-<api> Generates Javadoc APl docsfor the client-side API.

client-<api> Generates the specdocs, the Javadoc API docs for
the client side, the CAPI jar file and a Zip file
containing al of this.

clean-<api> Cleans everything for the API.
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rebuild-<api> Regenerates everything for the API.

all-<api> Generates everything for the API.

wsdl-<api> Generates the WSDL of the API.

stub-<api> Generates the API stub.

test-<api> Generates the unit tests if needed and tests the API.

javadoc-test-<api> Generates Javadoc for the unit test of the API.

opendoc-<api> Generates the specification of the API in open
document format.

al Generates everything.

clean Removes all generated files.

specdocs Generates all specification docs.

clients Generates client-<api> for al APls.

javadoc-capis Generates the Javadoc for all CAPIs.

javadoc-apis Generates the Javadoc for all APIs.

wars Createsthe WARs for all APIs.

tests Runs the unit tests of the APIs that have tests.

create-api Generates anew api specification file.

create-function Generates a new function specification file.

create-rcd Generates a new error code specification file.

create-type Generates a new type specification file.

create-example Generates a new example for afunction.

create-logdoc Generates the basic logdoc files for an API.

version or -version Prints the version of XINS.

help Prints the possible targets along with the possibles
APls.

XINS tools

XINS can also execute several tools that can improve the quality of your API.
To useit, execute xins <tool target>.

The target will ask you upon which APl you want to execute the tool. You can also pass the name of
the APl as a parameter name using - Dapi . name=<api nane> or add an api.name property to the
bui | d. properti es file

Y ou need to have the required librariesin the XI NS_HOWME\ | i b directory, unless specified otherwise.
» Xinshelp-tools

Description: Prints the list of the tool targets with its description and its required or optiona build
properties.

» xinsdownload-tools

Description: Downloads and installs the required libraries needed to execute the tools.
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e Xinsjavazhtml
Description: Generates HTML pages which contain the source code of the API.
Required library: j2h.jar [http://www.ibiblio.org/maven2/javazhtml/j2h/1.3.1/j2h-1.3.1.jar]
Web site: http://www.java2html.de/
Result location: bui | d\j 2h\ <api nanme>\i ndex. ht m
e Xinspmd

Description: Analyses the source code of the API. The default rules set is rul esset/
basi c. xm , rul esset/unusedcode. xm . You can override it by settting the pmd.rules

property.

Required library: pmd.jar [http://www.ibiblio.org/maven2/pmd/pmd/3.7/pmd-3.7.jar] and jaxen [http://
www.ibiblio.org/maven2/jaxen/jaxen/1.1-beta-11/jaxen-1.1-beta-11.jar]

Web site: http://pmd.sourceforge.net/
Result location: bui | d\ pnd\ <api nanme>\i ndex. ht
» Xinscheckstyle

Description: Checks  the source code  for compliance  to the Java
coding convention  [http://xins.sourceforge.net/X 1N S%20Java%20Coding%20Conventions%20-
%20v1.0%20-%20July%6202006.pdf]. It aso perform some analisys of the code.

Required library: checkstylejar [http://www.ibiblio.org/maven/checkstyle/jars/checkstyle-4.1.jar]
commons-beanutils.jar [ http://www.ibiblio.org/maven/commons-beanutil §/jars’commons-
beanutils-1.7.0.jar] antlr.jar [http://www.ibiblio.org/maven/antlr/jars/antlr-2.7.6.jar]

Web site: http://checkstyle.sourceforge.net/

Result location: bui | d\ checkst yl e\ <api nane>\i ndex. ht m
» Xinscoverage

Description: Reports on the coverage of the API code by the unit tests.

Required libraries: coberturajar [http:/Iwww.ibiblio.org/maven2/cobertura/cobertura/1.8/
cobertura-1.8.jar], asm.jar [http://www.ibiblio.org/maven2/asm/asm/2.2.1/asm-2.2.1.jar]

Web site: http://cobertura.sourceforge.net/
Result location: bui | d\ cover age\ <api name>\i ndex. ht m
* Xinsemma

Description: Reports on the coverage of the API code by the unit tests using the EMMA code coverage
library.

Required libraries: emmajar [http://mirrors.ibiblio.org/pub/mirrors/maven2/emma/emmal’2.0.5312/
emma-2.0.5312.jar], emma_ant.jar [http://mirrors.ibiblio.org/pub/mirrors/maven2/emma/
emma_ant/2.0.5312/emma_ant-2.0.5312.jar]

Web site: http://femma.sourceforge.net/
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Result location: bui | d\ cover age\ <api nanme>\i ndex. ht m
» xinsfindbugs

Description: Analyses the code in order to indentify possible bugs. You will need to set the
findbugs.home=<findbugs directory> build property.

Required library: Install findbugs.zip [http://surfnet.dl.sourceforge.net/sourceforge/findbugs/
findbugs-1.1.1.zip].

Web site: http://findbugs.sourceforge.net/
Result location: bui | d\ f i ndbugs\ <api nanme>\i ndex. htm
* xinslint4j
Description: Analyses the code in order to indentify possible bugs.
Required library: lintdj.jar [http://www.jutils.com/maven/lint4j/jars/lint4j-0.9.1.jar]
Web site: http://www.jutils.com/

Result location: bui | d\1i nt4j\<api name>\lint4j-report.txt and buil d\Ii nt 4]
\<api nane>\lint4j-report.xmn

» Xinsjdepend
Description: Analyses the package dependency and generates design quality metrics.

Required library: jdepend.jar [http://www.ibiblio.org/maven/jdepend/jars/jdepend-2.9.1.jar] in the
ANT_HOME\ | i b directory.

Web site: http://clarkware.com/software/IDepend.html

Result location: bui | d\ j depend\ <api name>\i ndex. ht m
» Xinscvschangelog

Description: Generates the change log report of the API.

Required library: None but cvs should be installed.

Result location: bui | d\ cvschangel og\ i ndex. ht m
* Xinsglean

Description: Generates a Glean report for the API. Glean is a tool agregator that produce a feedback
repost about the source code. Y ou will need to set the glean.home=<Glean directory> build property.
If not already provided, aapi s\ <api nane>\ gl ean. properti es fileis created that you can
customize to your wishes.

Required library: Install glean.zip [http://jbrugge.com/glean/glean-1.2.zip].
Web site: http://jbrugge.com/glean/
Result location: bui | d\ gl ean\i ndex. ht m

e Xinsjmeter
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Description: Generates JMeter [http://jakarta.apache.org/jmeter/] tests from the examples defined in the
functions.

Required library: None.

Web site: http://jakarta.apache.org/jmeter/

Result location: bui | d\ j net er\ <api nane>\<api nanme>. | nx
Xinsrun-jmeter

Description: Runs the IMeter tests. Y ou will need to the set jmeter.home=<jmeter directory> property.
You can set the jmeter.test property for the location of the tests without the extension. The default is
the location of the generated tests.

Required library: Install IMeter [http://jakarta.apache.org/jmeter/].

Web site: http://jakarta.apache.org/jmeter/

Result location: bui | d\ j net er\ <api nanme>\i ndex. ht m

xins maven

Description: Generates the Maven [http://maven.apache.org/] pom xm file for the specified API.
Required library: None.

Web site: http://maven.apache.org/

Result location: api s\ <api nanme>\ pom xm

xinssmd

Description: Generates the SMD [http://maven.apache.org/] (Simple Method Description) of the API.
Y ou can set the destination of the API with the smd.endpoint property. The default is the first address
intheenvi ronment . xm filewith?_conventi on=_xi ns-j sonrpc.

Required library: None.
Result location: bui | d\ snd\ <api nane>. snd
xins xsd-to-types

Description: Generates .typ fileswith the types defined in the given XML Schemafilesfor the specified
API.

Parameters: xsd.dir - Directory containing the XML Schemafiles (*.xsd)
Required library: None.

Result location: api s\ <api name>\*.typ

xins wsdl-to-api

Description: Generates an APl specification based on a WSDL [http://www.w3.org/TR/wsdl] file or
URL.

Parameters: wsd.location - The location of the WSDL (local file or URL)
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Required library: None.

Result location: api s\ <api  nanme>\api . xm api s\<api nanme>\*.fnc api s\ <api
nanme>\*.typ api s\ <api nane>\*.rcd

* Xinswebstart

Description: Generates a Java WebStart file (also called INLPfile) to run the API.

Required library: None.

Result location: bui | d\ webst art\ <api nanme>.jnl p

Note you will need to sign the WAR file if you want to make the APl available online.
* Xinsappengine

Description: Generates a Google App Engine of the Web Service.

Required library: Google App Engine SDK.

Result location: bui | d\ webapps\ <api nane>

Performances

XINS performances are regularly measured. An old article about XINS performance [http://
xins.sourceforge.net/articles/performance.html] shows that XINS could be even faster than the
competition.

The number of logs written per cal is one of the important factor that can slow down or increase the
performance of an API. You are advice to only log necessary messages.

Compressed data

Since XINS 3.1, GZip compressed data are al so accepted. If not already done, you are adviced to configure
the HTTP Server or the Servlet container to return compressed data.

If the Servlet container runs in a HTTP Server, it's better to configure the compression on the
HTTP Server. For example for Apache server, use mod_deflate [http://httpd.apache.org/docs/2.2/mod/
mod_deflate.html].

For Tomcat add to the server. xm <Connect or > element the
following attributes: conpr essi on="on" conpr essi onM nSi ze="2048"
noConpr essi onUser Agent s="gozi | | a, travi ata"

conpr essabl eM meType="text/htm ,text/xm ,application/xhtm +xm , text/
javascript, application/json".

For Jetty, you need to add a Servlet Filter [http://blog.max.berger.name/2010/01/j etty-7-gzip-filter.html].
Thisisdoneini mpl . xm with the following code:

<web-app elenent="filter">
<web-app el enent="filter-nane">&i pFilter</web-app>
<web-app elenent="filter-class">org.eclipse.jetty.servlets. GipFilter</web-app>
<l-- <web-app elenent="filter-class">org. nortbay. servl et. GipFilte</web-app> for
<web- app el enent ="init-paranm >
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<web- app el enent =" par am nanme" >m meTypes</ web- app>
<web- app el enent ="param val ue">text/htm , text/xm , application/xhtm +xm , applic
</ web- app>
</ web- app>
<web-app el enent="filter-anppi ng">
<web-app el enent="filter-nanme">&i pFilter</web-app>
<web- app el enent ="url - pattern">/*</web-app>
</ web- app>

For other servlet containers, you can add in a the Jetty filter by adding jetty library as dependencies and
the code above or use the pjl-comp-filter [http://sourceforge.net/projects/pjl-comp-filter/] project.

Cached data

Therearealot for cases in web services where getting data is much often called than creating or updating
data. For example, getting the data of the top 100 products of the catal og of getting the data of the currently
logged users.

XINS 3.1 adds the possibility to specify how long the data for a function could be cached on the client
side. Thisis done by adding a cache attribute to the function element in the f nc file. The value being the
number of seconds that the result could be cached.

<?xm version="1.0" encodi ng="US- ASCl | " ?>
<IDOCTYPE function PUBLIC "-//XINS//DTD Function 3.1//EN'" "http://xins.sourceforge
<function name="Fast Data" cache="60">

</ function>
If the client is abrowser the data will be cached automatically in the browser cache.
To use the cache system for the XINS client APl of with the XINSServiceCaller, you will need to

set the CachingHttpClient [http://hc.apache.org/httpcomponents-client-ga/httpclient-cache/index.html] in
XINSCallConfig:

XI'NSCal | Config config = new XINSCal |l Config();
config.setHtpdient(new Cachi ngHt t pClient(config.getHtpOient()));
capi . set XI NSCal | Confi g(config);

/1 or in the Xl NSCall Request: request.setXl NSCall Config(config);

Note that HttpClient cache is not included in XINS, so to use it you need to download it and add it to
the dependencies.

Note

HttpClient cache has support for advanced cache such as ehcache and memcache. Y ou can then
for example use a shared or distributed cache. If the same software is updating the data, you can
remove the cache entry when after the update function is called.

Not modified data

There are also cases where data should be accurate but is not often updated. For example the price or
availability of a product. In this case the server is returning al the time the same data, using unneeded
resources such as CPU and bandwidth.

XINS 3.1 add the notion of returning not modified to the client. In this case the HTTP status code 304 is
returned and no dataisincluding in the body of the message.
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Toreturn not modified, justaddr et ur n new Not Modi fi edResul t () ; intheimplementation class
when you know that the result isidentical to the last request of the same client.

Ontheclient side, ai sNot Modi fi ed() method has been added to XI NSCal | Resul t .
For the CAPI aNot Modi fi edExcept i on (which extends XI NSCal | Except i on) will be thrown.

Content of the XINS package

This chapter gives a description of the files and directories included in XINS package, so that you can
find the wanted information quicker.

Documentation

In the top directory of XINS, the following documents are available:

» README. ht ml contains a quick description of XINS, links to the documentation and quick start to
run asmall project.

» CHANCES contains the change logs between each rel eases.

* NOTES contains the release notes with the known bugs and the OS and Java version with which XINS
has been tested.

The docs directory contains the following documents:
e Theuser guide (it's this document)

» The Javadoc of the XINS.

The XINS primer. The primer is a description step by step on how to create your first API.

HTML Logdoc. This document contains a description of the message logged by XINS.

The XINS protocol. This document explains the communication protocol for the REST calling
convention.

On the website http://www.xins.org/documentation.html, the following extra documentation is available

e A document to help you migrate API [http://xins.sourceforge.net/articles/migration2-3to3-0.htmi]
written for XINS 2.3 or lower to XINS 3.0.

» Articles over Asynchronious cals [http://xins.sourceforge.net/articles/asynchronous.html], Result
caching [http://xins.sourceforge.net/articles/resultcaching.html], APl implementation with scripting
languages [http://xins.sourceforge.net/articles/scripting.html] and XINS performance [http://
xins.sourceforge.net/articles/performance.html].

* Presentations of XINS for managements [http://xins.sourceforge.net/presentations/xins_intro.pdf] and
devel opers [http://xins.sourceforge.net/presentations/frameworks_and_xins.pdf].

Examples

Three API examples are distributed with XINS. The API's are located in the directory deno\ xi ns-
proj ect.

Here is adescription of the API's:

e myproj ect: Thisexampleisavery basic example, much like a"Hello World" example.
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e al | i none: Thisexample uses most of the featuresincludingin XINS. The API contains 1 new feature
per function.

« filteredproject: Thisexampleisan API that uses the generated CAPI to call another API (the
myproject APl).

The examples aso include client examples. This shows how to call an API using different programming
languages.

The most interesting examples are the Ajax [http://en.wikipedia.org/wiki/Ajax_%28programming%29]
examples located in the directory deno\ capi s\ j avascri pt. These examples show how to call a
XINS API synchronioudly or asynchroniously with Javascript and insert the result in the current HTML

page. XINSworks particularly well with Ajax thanksto the REST calling conventionand the XSLT calling
convention.

Here is a description of the Ajax examples:

* call MyFunction. ht m calsthe XINSAPI using the REST calling convention and insert the result
of the call in the web page.

e cal | Met aFuncti on. ht M callsthe XINS API using the XSLT calling convention and insert the
HTML returned by the call in the web page.

* cal Il MyFuncti on2. ht m callsthe XINS API using the REST calling convention and tranform the
returned result using XSLT on the client side. It then insertsthe HTML in the web page.

Note

Because of security issues, when these examples are executed locally using Netscape as browser,
cal | MyFunction. ht M will ask for authorisation, cal | Met aFuncti on. ht m will fall
andcal | MyFunction2. ht m will fail.

XINS aso contain examples on how to call an APl using PHP version 4 and 5, Perl and Java. If you want
to call aXINS API using another language, just call the API using the URL and parse the returned XML.
Y ou can aso use the SOAP calling convention or the XML-RPC calling convention.

Program

The package not only contains the documentation and the examples, it contains also the program :-).
The program islocated in different directories:

* bi n contains the shell scripts. This directory should bein you PATH environment variable.

* bui | d containsthe XINS library.

* | i b containsthe third party libaries used by XINS with their license.

e src contains XINS source code aswell asthe XSLT, XML and css files used for the code generation.

A Antbui | d. xml script is provided in the root directory in the case you want to recompile XINS.

Integration with IDE

This chapter will help you to configure a development environment so that you can create, develop, test
and debug a project faster.
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If you have found some more settings that hel ped you to develop the XINS API faster using Eclipse, send
the procedure to anthony.goubard@japplis.com [mailto:anthony.goubard@japplis.com].

Integration with Eclipse.

The Eclipse version used for this manual is 3.2 and can be found at http://www.eclipse.org/platform.

Note

Asdescribed in theinstall section, if you're using the Ant distribution included with Eclipse, you
may need to copy xercesimpl-2.6.2.,jar [http://mirrors.ibiblio.org/pub/mirrors/maven2/xerces/
xerceslmpl/2.6.2/xercesimpl-2.6.2.jar] to the pl ugi ns\ org. apache.ant _1.6.5\I1ib
directory to avoid putDocumentlnCache error messages. If you still havetheerror, install Ant and
go to Window -> Preferences -> Ant -> Runtime -> Ant Home... and choose the Ant directory.

As Eclipse locks the opened files, you choose close them before calling the create-xxx targets.
For example xi ns- pr oj ect's. xm should be closed before calling create-api.

xins eclipse

If the xins-project.xml is not already created, create it in a new directory with the content specified in
the section called “xins-project.xml”.

In Run -> External Tools -> External Tools, create a new program with the name xi ns, the location
set to the xi ns\ bi n\ xi ns. bat file and the working directory to the directory containing xi ns-
pr oj ects. xml . Thenyou need to add in the argumentsthe ${ st ri ng_pr onpt } variableand add
in environment the variable XI NS_HOVE with the value of the XINS directory.

If the API is not created, click on the run button and enter cr eat e- api . Thistarget will ask a series
of question in order to create the API including the first function of the API.

Click on the run button and enter ecl i pse. Enter the name of the API.

The command will create a xi ns-eclipse.userlibraries in the xi ns\src\tools
\ ecl i pse directory. Then go to Window -> Preferences -> Java -> Build Path -> User Libraries -
> Import... -> Browse and select the xi ns- ecl i pse. user|i brari es file. This step only needs
to be done once.

After the eclipse command, depending on the directory location of the api:

« If your project is outside your workspace, choose File -> New -> Project... -> Java -> Java Project ->
fill the project name -> Create project from existing source and choose the apis\<api name> directory
-> Finish.

« If your project is in your workspace, choose File -> Import... -> General -> Existing Projects into
Workspace -> Next -> choose the apis\<api name> directory -> Finnish.

Run it with Tomcat plug-in.

In order to be able to run and debug your web application, you'll need to instal Tomcat
(http://jakarta.apache.org/tomcat/) and the Tomcat plug-in for Eclipse (http://www.sysdeo.com/eclipse/
tomcatplugin).

Configure the Tomcat plug-in in the Preferences:

» Set the Tomcat home to the location where you have installed Tomcat
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e Add, in the JVM settings, the JVM parameter - Dor g. Xi ns. server. config=c:\java
\tontat\conf\xins.properties (the xins.properties could aso be in another
directory). For more details about the xi ns. properti es, read the section called “The runtime
properties’.

» Changethe Configuration fileto api s\ <api nanme>\tontat -server.xm .

e Start Tomcat.

Run it and debug it with Jetty plug-in.

You can aso use the Jetty plug-in for Eclipse. To instal it, go to Help -> Software Updates -> Find and
Install... -> Search for new featuresto install -> Add Update Site. Then enter the name JettyL auncher and
the URL http://jettylauncher.sourceforge.net/updates/.

» Create an Jetty XML fileto link adirectory to the bui | d/ webapps/ <api >/ <api >. war file.
* Goto Run-> Run...

 Create anew Jetty Web project

» Set aname for the project, set the Jetty home

 Click on Use a Jetty configuration file and set the value to the Jetty XML file you've created

» Go to the argument tab and add the parameter - Dor g. xi ns. server. confi g=<jetty_hone>
\etc\ xi ns. properti es.

» Now you can run, add breakpoints and debug your web application using the buttons on the toolbar
Other improvements.

With Eclipse, by changing the code and saving it you can run your modification without recompiling if
the modification is minimal. If you modified alot of code, you will need to regenerate the war file.

If you have also generated the specific documentation you may want to use the test forms or the example
to test your project. To do so, create anew External tool named specdocs with the main program linked to
your HTML Browser and the arguments set to bui | d\ specdocs\ <api >\ i ndex. ht ml file.

In order to be able to edit the specifications that are in XML, we also advise that you instal a
XML plug-in for eclipse such as XMLBuddy (http://www.xmlbuddy.com/) or XML Author (http://
www.svcdelivery.com/xmlauthor/). Then in Preferences -> Workbench -> File Associations, add * . f nc,
*.typand*.rcd associated with the XML tool.

If you execute the cl ean target, you may have afterwards a window popping up asking you to choose

between bui | d. xm andbui | d. xm (1) . Toremovethiswindow go to External Tools... menu and
removethebui | d. xml (1) configuration.

Integration with NetBeans
The version of NetBeans used for this manual is 5.0 and can be downloaded at http://www.netbeans.org/.
Setting up the project.

An Ant script for NetBeans 5.0 or higher is provided with XINS. It requires a correctly set XI NS_HOVE
environment variable.
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» AddtheDTD catalog by clicking ontheruntimetab, right click onthe DTD and XML Schema Catalogs
item and add the OASIS catalog located at sr ¢\ dt d\ xi nsCat al og. xn .

» Register someextensionas XML filesinTool s -> Opti ons -> Advanced Options -> | DE
Configuration -> System -> (hject Types -> XM.Objects -> Extensions
and M ME Types by adding theitemsf nc, t yp, r cd and cat . Check also at the same time the

XML Indentation Engine settings. From NetBeans6.5Tool s - > Opti ons -> M scel | aneous
-> Files

* Opentheproject in deno\ xi ns- proj ect\ api s\ pet store.
« If the API already exists, executethe copy- nb-fi | es target of thenbbui | d. xmi .

 If you want to create a new API, execute the cr eat e- api target. This target will ask a series of
guestion in order to create the API including the first function of the API.

» Open the project by selecting the directory of the API: <pr oj ect dir >\ api s\ <api nane>

» You can now open your function implementation file and write it's implementation in the Resul t
cal | (Request request) method.

* Click on the Compile button to compile, on the Run button to run your API, on the Debug button to
debug it or on the Apply Code Changesif you have modified the code with debugging.

e Toprofilethe API, install NetBeansprofiler (http://profiler.netbeans.org/) and execute the profil e target.

In NetBeans, the targets can be executed by right-clicking on the nbbui | d. xm and Run t ar get or
by right-clicking on the project icon or by using the toolbar if your project is the main project.

In NetBeansyou can set conditional breakpoints or exception breakpointsthat stop the debugger whenever
an exception is thrown.

Targetsto deploy your APl in Tomcat are provided. Y ou can then use the Netbeans HTTP Monitor with it.

If NetBeans 6 has problems to recognize the Request and Resul t objects, you can add the option -
J- DCached assPat h. keepJar s=t r ue inthe Netbeans et c\ net beans. conf file.

Integration with other frameworks

XINS is based on severa standard such as POJO, Servlet API, SOAP, REST or Ant which eases the
integration with other frameworks.

Spring framework

XINS can easily be integrated with the Spring Framework [http://www.springframework.org/].

XINS generates POJO's for requests and result on the client and server side. The classes and the methods
are public so that they can be called from another package. The generated POJO's try to follow the Java
Beans specification as much as possible.

For example, if you want to use Spring AOP transaction for a specific API, you can define as point cut all
methods starting with call in the generated CAPI class.

On the server side, XINS is a Servlet so you can use it with org.springframework.web.servlet.* [http://
www.springframework.org/docs/api/org/springframework/web/servl et/package-summary.html].

60


http://profiler.netbeans.org/
http://www.springframework.org/
http://www.springframework.org/
http://www.springframework.org/docs/api/org/springframework/web/servlet/package-summary.html
http://www.springframework.org/docs/api/org/springframework/web/servlet/package-summary.html
http://www.springframework.org/docs/api/org/springframework/web/servlet/package-summary.html

XINS User Guide

XINS aso includes a Spring framework package. The package is located in
or g. xi ns. comon. spri ng (javadoc [javadoc/org/xins/common/spring/index.html]). This package
isadding afew convinient classes for validation, factory bean and client interceptor.

If you want to load and access an Application Context in the API, you need to add Spring, and a listener
toi npl . xm :

<web- app el ement =" cont ext - par ani' >

<web- app el enent ="par am nane" >cont ext Confi gLocati on</ web- app>

<web- app el ement =" param val ue" >/ VEB- | NF/ appl i cat i onCont ext *. xm </ web- app>
</ web- app>
<web- app el enent="Iistener">

<web- app el enent="Iistener-class">

or g. spri ngframewor k. web. cont ext . Cont ext Loader Li st ener

</ web- app>
</ web- app>
<content dir="api/nyproject" includes="applicationContext*.xm" />
<dependency dir="spring" includes="spring.jar" />

Then to get access to the bean defined in the application context use annotations such as @onponent
or @Aut owi r ed.

Dojo toolkit

The Dojo toolkit [http://dojotoolkit.org/] has several waysto communicate with the server.

One of it is JISON-RPC (dojo.rpc.JsonService) which is also supported by XINS on the server side with
the _xi ns-j sonr pc caling convention. The easiest way to use this JsonService is in combinaison
with a SMD (Simple Method Description). SMD is a file which describes the name of the methods of
the API with the expected parameters. There are two ways to get this file from XINS. Either execute the
xins smd command that will generate the file bui | d\ snd\ <api nane>. snd or by calling the meta
function _SMDto the APl you want to invoke. An exampleis provided indenp\ capi s\ j avascri pt

\cal | MyFuncti onDoj 0. ht m .

You can aso use dojo.rpc.YahooService where calls will be received by the xi ns-j son calling
convention. This service isalso able to read and interpret the SMD file.

Google Web Toolkit (GWT)

GWT [http://code.google.com/webtoolkit/] has mostly two ways to communicate with a
server. They first have their own RPC system [http://code.google.com/webtoolkit/documentation/
com.googl e.gwt.doc.Devel operGuide.RemoteProcedureCalls.html]. GWT also facilitatesthe call to APIs
using the Y ahoo JSON protocol which matchesthe _xi ns-j son calling convention.

An exampleis provided at http://gwt.google.com/samples/JISON/JSON.html.

Note that XINS also supports the callback parameter which is use to indicate to the call which method
should be called with the output parameter when the response returns.

AJAX

The others (than Dojo and GWT) AJAX frameworks are also supported.

They have different waysto call XINS. They can usethe _xins-json or _xins-jsonrpc calling conventions
but also the xins-std and parse the returned XML themselve or use the _xins-xdlt calling convention in
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Mule

combination with an XSLT stylesheet that transform the XML in the HTML to insert dynamiccally in
the page.

Several examples of the later are provided in thedeno\ capi s\ j avascri pt directory.

Mule[http://mule.codehaus.org/display/M UL E/Home] isthe most popular open source Entreprise Service
Bus (ESB).

As XINSisaServlet, you can register ahandler on the URI (embedded Jetty), or bind through an existing
web container (servlet endpoint).

Documentation can be found in the org.mule.providers.http.jetty [http://
mule.codehaus.org/docs/apidocs/org/mul e/providers/http/jetty/package-summary.html] package or in the
org.mule.providers.http.servliet [http://mule.codehaus.org/docs/apidocs/org/mule/providers/http/serviet/
package-summary.html] package.

ESB and JavaEE

Ant

Most of modern ESB support the possibility to plug JavaEE servers to it and as part of the JavaEE
specification there is the possibility to deploy and run Servlet, there shouldn't be any problem to install
XINS APIsin an ESB and/or JavaEE server.

The main problem can only be to indicate where find the runtime properties file, as it is normally done
using the org.xins.server.config system property. If you cannot set this property, you can also include the
runtime property file to use in the WAR file as WEB- | NF/ xi ns. properti es. Usethe <cont ent
di r="<pat h>" includes="xins.properties" web-path="VWEB-INF" /> eementin
i mpl . xm file.

Orchestration is also an important feature in ESB. It can be done using WS-BPEL as XINS APIs can
communicate using SOAP with the _xi ns- soap calling convention. The API can also give the WSDL
file to indicate the SOAP message format with the _WSDL meta function.

XINS uses Ant to generate the different files. It isalso possible to run the tests or the API with Ant targets.
The easiest way to do it isto use the xins task as described in the the section called “xins task”.

Another possibility isto look at the nbbuild.xml file included with the petstore demo and can be used for
other existing APIsor new APIs. Note that some of the targets are NetBeans specific but most of them not.

Maven

XINS also has support for Maven 2.

Each stable releases are added in the Maven 2 repository (http://www.ibiblio.org/maven/org.xing/). Note
that not only the jar files are included, the source code and the Javadoc are also included.

If you want to build your API using API using Maven, you can execute xins maven command which will
createthe<api nane>. pomintheapi s\ <api nane> directory. Notethat the external dependencies
(other than XINS) are not included in the generated POM and you should add them manually.
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Script languages (Groovy, Ruby, PHP, Perl...)

On the client side it is possible to either call the standard calling convention or use a standard protocol
such as SOAP or XML-RPC.

As the standard calling convention is simple, it should be easy to write a script that creates a URL, send
it and parses the XML response returned.

Some of the script also havelibrariesto call aserver by using SOAP or XML-RPC. XML-RPC clientsare
listed at http://www.xmlrpc.com/directory/1568/implementations.

Examples with different script are provided in the deno\ capi s directory.

You can also implement an API using a script language. In this case you need to use alibrary to pass the
input parameters to the script and get the output parameters from the script. An example is provided in
XINS using Groovy as script language in thedeno\ xi ns- pr oj ect \ api s\t ool box directory.

Google App Engine (work in progress)

Since XINS 2.3, anew command xins appengine allow to package the API and deploy it on the Google
App Engine [http://appengine.google.com].

Y ou will need to specify the location of the appengine SDK with the appengi ne. sdk. di r property.

The Google App Enginerequiresaappengi ne- web. xm inthe WEB- | NF directory. If you don't have
one XINS will create one for you (in bui | d/ webapps/ <api name>/ war / V\EB- | NF). Y ou may
need to change the application name and version (. and _ are not accepted in version). Another possibility
isto set appengi ne. api . nane and appengi ne. api . ver si on build properties.

Also as there is no runtime properties, the file specified in the or g. xi ns. server. confi g build
property will be used.
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